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As a member of the University of Alaska you will soon be required to become familiar 
with, and use, Google mail (Gmail). This short guide will show you how to best make 
use of Gmail to organize and improve your contacts with students and others. You will 
also learn how to implement the free Google offi  ce tools (Google Docs) to add ele-
ments of collaboration and peer review to your online courses. 

Topics Covered in This Section
 • Introducing Gmail

 • Address Book

 • Composing Mail 

 • Using Labels and Archiving

 • Searching your Mail

 • Changing Settings

 • Introducing Google Docs

 • Documents

 • Spreadsheets

 • Presentation

 • Additional Resources

Abstract
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Gmail is a full-featured webmail program that includes support for essential webmail 
functions including labeling, a very accurate spam fi lter, a powerfully advanced search 
feature, and an easy-to-use address book that includes the ability to group contacts 
and to import and export your contacts from other programs.

Furthermore, you have the ability to chat with your contacts in real-time using an in-
tegrated instant messaging feature called Google Talk. You can customize your pre-
ferred language, add signatures to your email, create vacation auto-responders, send 
and receive email from other accounts (even one’s that aren’t Gmail-based), create 
fi lters, enable forwarding, and change the look of your Gmail interface.

Gmail has almost unlimited storage space for your e-mail as well. No more will you 
have to worry about deleting messages over two or three months old. 

One of the nicest features of Gmail is that messages are automatically saved in the 
Drafts folder as you type. Thus, if something happens while you are writing your mes-
sage, whatever you typed is automatically saved in the system, so when you log back 
into Gmail your message will still be ready to be fi nished or sent.

Address Book
Before you start using Gmail you’ll probably want to 
add your contacts to the Gmail address book, which is 
called just ‘Contacts’ in Gmail. Go ahead and click the 
Contacts link on the left-hand side to get started.

Click one of the insert contacts button above the words 
My Contacts to add an individual contact or a group. 
Or, click the Import link on the right-hand-side to im-
port contacts from an excel spreadsheet (CSV format 
works best). Click the Export link to export your exist-
ing Gmail contacts to a spreadsheet in CSV, or vCard 
format.

When you add a contact individually you can add many details about the contact includ-
ing name, title, company name, e-mail address(es), phone numbers(s), address(es), in-
stant messaging address(es), notes, and even a picture if you have one.

Introducing Gmail
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Composing Mail
Once you have your contacts in Gmail you might want 
to send a message! Just click the Compose Mail link 
under the University of Alaska banner in the upper-left-
hand side of the page. 

Your compose mail interface will look familiar to other 
e-mail programs. You’ll have a send button, a discard 
button, a to fi eld, subject fi eld, and the body of the mes-
sage, a signature if you’ve added one (under settings), 
and an editor for formatting your e-mail message.

You may also notice a button that says Save Now, which 
allows you to manually save an e-mail you are working 
on in the Drafts folder (located on the left-hand side of 
the screen). But you usually don’t need to use this but-
ton because Gmail automatically saves your messages 

every few minutes. Note in the screenshot how it says Draft autosaved at 3:38 PM. This 
is just a note to let you know when Google automatically last saved your e-mail mes-
sage. If your computer goes offl  ine suddenly, your e-mail message will still be available 
for you to fi nish and send when you get back online.

You can format your messages using the formatting toolbar. Options for formatting 
your messages include bolding, italics, underline, font, text color, lists, indenting, quo-
tations, text alignment, and there is even a spellchecking tool.

When you’re done crafting your message, just click the send button.
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Using Labels and Archiving
You use labels to organize your mail. Now, you don’t have to of 
course, but labeling your mail makes it easy to fi nd messages once 
your mailbox gets overwhelmed with mail. You could also just star 
the message and come back to it later, but labeling has the added 
advantage of cutting down the size of your inbox and also allow-
ing you to put a name on the message that will make it easy to 
retrieve later using the search tool, or just by clicking the name of 
the label on the label sidebar, which will bring up all messages with 
that specifi c label. Think of a label as a folder or a category.

To label a message just click the checkbox next to the message 
you want to label and select the Labels drop-down menu above 
your message. In the drop-down select the label you want to ap-
ply, or create a new label by typing the name of the label in the text fi eld.

Searching your Mail

A particularly useful feature of Gmail is the ability to search your mail for messages. It’s 
not just a basic search either; it’s a very powerful search that allows you to search the 
from, to, body, and subject fi elds of your messages. Moreover you can choose what 
words to include in your search and which one’s not to include. You can search by date 
range. Last but not least you can search in your inbox, any of your labels, your trash, 
sent mail, and even your spam box for messages that match your search criteria.

Changing Settings
You can change certain settings in your Gmail account to streamline it to your way of 
working. Click the Settings link in the upper-right-hand corner of the page to access 
the settings dialog.

In the settings dialog, you’ll see multiple tabs including: General, Accounts, Labels, Fil-
ters, Forwarding and POP/IMAP, Chat, Web Clips, Labs, and Themes. The General tab is 
selected by default. Here you can change your preferred language (the default is Eng-
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lish), your picture, signature, and vacation responder. Whenever you make changes to 
the settings in any of these tabs click the Save Settings button at the bottom of the 
screen to save your selections.

In the Accounts tab you can add other email addresses you use frequently. Doing so 
will allow you both to receive messages from other accounts you specify and send 
messages from those other accounts. This is a very effi  cient feature!

The Labels tab is just a shortcut for adding, renaming, and deleting your labels.

To add a new theme to your Gmail account select the Themes tab and choose the 
theme you think looks best. If you don’t like any of them select the link that says 
Choose your own colors.
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Introducing Google Docs

With Google Docs you can easily create documents, spreadsheets, and presentations. 
The amazing thing is they all work fairly similarly to what you would expect from the 
Microsoft Offi  ce products, except of course they are completely online. 

You’ll fi nd Google Docs to have most of the common features of Microsoft Word, Ex-
cel, and PowerPoint, although it is missing some features that are less commonly used. 
For most people however, the features that are included will be suffi  cient. In any case, 
you don’t need to replace Microsoft Offi  ce. Think of Google Docs as a supplementary 
toolkit for online collaboration.

Once you’re logged into Gmail, click the Documents link in the upper-left-hand corner 
of the page to visit Google Docs. At fi rst because you haven’t yet created any docu-
ments you will see a virtually blank interface, save for some buttons on the top, and 
links down the left-hand side.

Next to the University of Alaska logo is a search fi eld where you can search all your 
documents if you have any - by the words included in them, or by what they are named. 
You can also search documents by type.

Below the search bar is a toolbar 
where you can choose options 
such as creating new documents, 
spreadsheets, presentations, or 
folders, uploading existing docu-
ments, sharing and moving docu-
ments, hiding, deleting, and re-
naming documents.
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You can upload documents you have created from other programs. You can upload 
HTML, plain text, Word, Rich Text, PowerPoint, CSV, XLS, and PDF documents. Just 
select the Upload tool button, fi nd the fi le on your computer, or the Internet, you want 
to upload, give it a name, and click Upload File. 

On the right side of the main page you’ll see various options for fi ltering your fi les. For 
example, you can choose to see all the things you have hidden or trashed. You can 
also view any searches you have performed in the past as long as you saved them. You 
can also view documents by type, such as PDF, and you can view documents you have 
shared with specifi c individuals; just click the item by which you wish to fi lter and the 
main documents area will be updated to refl ect your fi ltering.

Documents

Select New > Document to create a new document. When you fi rst create a document 
you’ll see it has a title which is Untitled by default. You can either select File > Rename 
to change the name to something else, or you can just start typing. The fi rst words you 
type will become the title of the document  but don’t worry, you can always change it 
later!

Notice how the menu and toolbar look roughly similar to Microsoft Word, but with 
many fewer bells and whistles. Some of the most useful features include the various 
editing tools, the ability to share and collaborate on documents, and revision history. 
Let’s discuss the editing tools fi rst.

Besides all of the regular tools such as being able to save, 
rename, and load documents, format text, insert links, 
add tables, fi nd and replace text, and insert images, there 
are some editing tools that are really handy and surpris-
ing given that these are free, online tools that anyone 
can use.  
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There is, for instance, a very good spell checker. There is also a language setting, so if 
you are writing your documents in a language other than English, you can change the 
language setting and the spellchecker will work with the new language. Finally, there 
is a word count feature and a dictionary and encyclopedia. All these tools are available 
under the Tools menu. 

You can easily insert a table of contents, head-
ers or footers, and footnotes as well. These tools 
are all available under the Insert menu.

As you can see, Google Docs provides many use-
ful tools for creating and editing documents. 
But the most innovative feature is the ability to 
collaborate on documents. No longer will you 
have to send hefty attachments to students and 
peers - attachments that routinely get ‘lost’ on 
the web or put in spam boxes. No longer will 
you need to worry needlessly about whether a 
student has the same version of MS Word, Excel, 
or PowerPoint. You, or your students, can now 
create a document on the fl y and allow others to view or edit it. This is a great tool for 
commenting on student work or allowing students to work together on projects.

To share a document with someone, just click on the Share drop-
down menu in the upper-right hand corner and select Share with 
Others. Another dialog will open that will allow you to invite peo-
ple to either collaborate or view your document. You can add as 
many e-mail addresses as you like, so you could send a document 
to all your students. They, in 
turn, can send documents they 
create to you or any of the other 
students. You can even publish 
the document so anyone in the 
UA system who knows the link 
can view it!

If you’ve shared your document 
with others and you don’t like 
the changes they’ve made, you 
can revert the document back to 
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a previous version. This feature is called 
‘revision history’. Because Google Docs 
saves your fi les automatically ever few 
minutes, that’s a lot of drafts you can re-
vert to. This is a very handy feature!

Spreadsheets

Select New > Spreadsheet to create a new spreadsheet. When you fi rst create a 
spreadsheet you’ll see it has a title which is Untitled by default. You can either select 
File > Rename to change the name to something else, or you can just start typing. The 
fi rst words you type will become the title of the spreadsheet – don’t worry; you can 
always change it later.

Notice how the menu and toolbar looks roughly similar to Microsoft Excel, but with 
many fewer bells and whistles. Some of the most useful features of Google Spread-
sheet include the various editing tools, the ability to share and collaborate on docu-
ments, and revision history. Most of these features we’ve already covered when we 
talked about Google Docs, but we’ll cover some of the editing features specifi c to 
Google Spreadsheet here.

Google Spreadsheet has many of the features 
you would expect from a spreadsheet program 
such as the ability to save, rename, and load doc-
uments, format cells, freeze rows and columns 
to make them easier to work with, create noti-
fi cation rules, fi nd and replace text, and insert 
images.
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Google Spreadsheet also has an awesome collec-
tion of formula for you to choose from. To insert 
a function into a cell or range of cells select Insert 
> Formula … > Formulas to open up the Formulas 
dialog box. When you explore the formulas dialog 
you’ll see there are quite a few formulas to choose 
from, just as there are in Excel.

You can also insert charts and gadgets into your 
spreadsheets. Gadgets are little widgets created 
by Google and other application developers, to 
give your spreadsheets added functionality. You 
can include gadgets such as Gantt and organi-
zation charts. To insert a gadget select Insert > 
Gadgets and choose from the collection. If you’d 
rather just have a chart select Insert > Charts.  

Presentation

Select New > Presentation to create a new presentation. When you fi rst create a pre-
sentation you’ll see it is called Untitled Presentation by default. Select File > Rename 
to give your presentation a good name.

Notice how the menu and toolbar look roughly similar to Microsoft PowerPoint. Just 
like Google Documents and Spreadsheet you have various editing tools, the ability to 
share and collaborate on documents, and revision history available to you. Most of 
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these features we’ve already covered, but we’ll discuss some of the editing and other 
tools available specifi cally to Presentation here.

Google Presentation has many of the features you would expect from a presentation 
program such as the ability to save, rename, and load documents, change themes and 
background, fi nd and replace text, insert images, shapes, and video, and arrange slides.

You also have the ability to upload presentations you’ve created in Microsoft PowerPoint 
or in Google Presentation. Simply select File > Upload a Presentation to do so. You can also 
import slides that you’ve already created by selecting Insert > Import Slides.

Once you have made your presentation you can download it as a PowerPoint presen-
tation, if you wish, so you can present it like you normally would. Just select File > 
Download Presentation As… and choose to download your presentation as a PPT, 
PDF, or text fi le. 

Once you are ready to present, it’s very easy to show or share a presentation in Google 
Presentation as well. Just select the Start presentation button in the upper-right-hand 
corner to begin your slideshow. You’ll see a link in the slideshow you can share with 
anyone else so they can see your presentation. You can even text chat while showing 
your presentation to others. 

Additional Resources
10 Reasons to use Gmail: http://mail.google.com/mail/help/about.html

Why use Gmail? http://www.youtube.com/watch?v=uBbmiQhuAhU [video]

Gmail for your Phone: http://www.google.com/mobile/default/mail.html

Google Docs for Educators: http://www.google.com/educators/p_docs.html

Getting Help with Google Docs: http://docs.google.com/support/?hl=en

Google Docs in Plain English: http://www.youtube.com/watch?v=eRqUE6IHTEA [vid-
eo]

Google Docs Templates: http://docs.google.com/templates

Sites created within the UA System: https://sites.google.com/a/alaska.edu/sites/sys-
tem/app/pages/meta/dashboard/categories

Getting Help with GoogleSites: http://sites.google.com/support/?hl=en
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Google Sites
Google Sites allows you to make collaborative websites quickly and easily. You don’t 
need any technical knowledge to create a website on Google sites. You can design 
your own using a tool editor similar to the one in Blackboard or you can just use one 
of the many customizable templates available for free. You can upload fi les and at-
tachments to your site and embed rich content. 

To get started creating a new Google Site simply select the Sites link at the top-left-
corner within your Google Apps account and click the Create new site button that 
you see. You’ll then be directed to another page that looks as follows:

Name your site. Your URL (or address) will be created automatically for you – al-
though you can change it if you want. Select the theme you want to use from a 
template and click Create Site. That’s all there is too it! Making a website has never 
been so easy.

Once you’ve created your site you can add links to the navigation menu, create pag-
es, edit pages, and allows others to see or edit your pages as well so you can work 
together on the site. Google Sites act like wikis in that people can collaborate easily 
while also preserving a log of who changed what and when so you can undo edits 
others have made. Google Sites is a great tool to use in classrooms to allow students 
to work together in knowledge creation.

You can attach fi les to sites and also comment on pages people have created. This is 
a great way to provide feedback to student work within Google Sites.
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Digital Literacy
What do we mean when we talk about digital literacy? Is it a our ability to eff ectively 
navigate through a digital environment? How do we communicate eff ectively  with 
others with so many tools at our disposal? How do we access information productive-
ly when the amount of information available continues to grow exponentially?  The 
level at which we respond to these questions is evidence of our digital literacy.

The Internet is an environment capable of presenting a multiplicity of formats - text, 
audio, and video all at once. It enables us to interact with information and people 
from around the world synchronously or asynchronously. These aff ordances are 
changing the very nature of how we communicate with each other - at home, with 
extended family and friends, and at work.

Digital literacy isn’t a set of skills that are “nice to know”. It is something we, as edu-
cators, must master well enough to pass onto our students. They must learn these 
skills to be successful in the professions we are preparing them for.

This section will introduce you to tools to assist with reading and interpreting data, 
reproducing/manipulating it, and discerning its validity.

KEYBOARD SHORTCUTS
Keyboard shortcuts aren’t just for programmers. Knowing the keyboard shortcuts for 
repeated tasks may seem like something small, but they save a great deal of time.

Command PC MAC
Select All CTRL + a Open Apple + a

Cut CTRL + x Open Apple + x

Copy CTRL + c Open Apple + c

Paste CTRL + v Open Apple + v

Undo CTRL + z Open Apple + z

Find CTRL + f Open Apple + f

Help F1 Open Apple + ?

Minimize all windows Windows Key + m Open Apple + m

Switch windows ALT + Tab Open Apple + Tab

Close window ALT + F4 Open Apple + w

Select multiple from list Shift + Click Shift + Click
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USING THE CONTEXT MENU
The context menu is another short-
cut to access commands in a pro-
gram. While using the context menu 
isn’t as fast as using a keyboard 
shortcut, it is still faster than using 
a program’s menu bar.  Access the 
context menu by right-clicking if 
you’re on a PC, or CTRL +clicking if 
you’re on a Mac.

Be aware that commands available 
in the context menu change de-
pending on what part of a program 
you are in. Knowing when certain 
options are available saves time by 
allowing you to keep your cursor 
close to your work instead of surfi ng the main menu.

PASSWORD MANAGEMENT
Something that is diffi  cult to guess but easy for you to remember your the goal when 
creating passwords. A good password is patterned but not predictable. The pattern 
assists with memory recall, but inevitably, you will fi nd yourself forgetting a login from 
time to time. Maintain a master fi le of passwords but be sure that fi le is safe from pry-
ing connections on your computer. There are password management programs that 
can keep your passwords safe and accessible. You can also keep your master fi le on an 
encrypted fl ash drive (just don’t lose it!).

Checking the validity of the site where you enter your personal information is as im-
portant as keeping your passwords secure. When using your passwords online pro-
tect yourself by checking that the address of the page(s) you enter your user/pass on 
begins with https://. This indicates that your information will be transmitted over the 
network securely. 

Look at the rest of the address and ensure it belongs to the domain owned by the 
entity/company/person it should. Look at the spelling of the domain. Fraudulent web 
sites often use misspellings of popular web site names to trick users into sending their 
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sensitive information to the site.

Don’t :

 • store passwords on Post It Notes that you then leave on your computer screen

 • use short words, names, dates, SSN, any easily accessible information about your-
self

 • any of the above spelled backward

 • email your user/pass to anyone

 • transmit your user/pass over IM

Do:

 • Use a combination of 8 or more letters, numbers, and special characters

 • check for  https://

 • ensure the web site domain is valid and correct

 • change your password periodically even if it has not been compromised

THE BROWSER
Your web browser is a window 
onto the web and if you fi nd 
yourself spending more and 
more time online that brows-
er should be helping to make 
that time more productive.  
Finding a browser that is right 
for you and customizing it to 
fi t your particular needs are 
the fi rst steps. A good brows-
er to start with is FireFox. 
FireFox is highly customizable 
and incorporates features 
such as tabs and a pluggable 
architecture. The pluggable architecture enables you to install extensions and plugins 
to enhance the functionality of your browser easily without having to program it your-
self. FireFox is also open source software with a rich community that contributes in or-
der to continuously make the browser better. FireFox is a free download available at:
http://getfi refox.com
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Tabs

Tabs are a mechanism that allows you to open many web pages in the same browser 
window. This can reduce desktop clutter and assist in organizing your workspace by 
giving you a way to display all pages related to one task in one window,. 

FireFox enhances the tab feature even further by allowing you to implement Session 
History. Your Session History will remember how many windows and tabs you had 
open during your last session (or previous sessions) and open them all for you the 
next time you restart your browser.

Extensions

There are numerous extensions that enable you to customize the functionality of 
your browser to help you with your online tasks. Think of extensions as tools and 
your browser as a toolbox. Depending on the job you’re doing, you will need diff er-
ent tools in your tool box. 

Extensions can seamlessly connect you to online services you may already use such 
as a bookmarking service such as del.icio.us or Diigo, a photosharing site like Flickr 
or Picasa, or to your own blog. By extending Firefox to integrate with other services 
you use online you no longer have to visit those sites as often. You can browse the 
Mozilla web site to see what sorts of extensions are available: 
https://addons.mozilla.org.

Here are a few extensions to get you started.:

 • All-in-One Sidebar
Lets you quickly switch between sidebar panels, view dialog windows such as 
downloads, extensions, and more in the sidebar, or view source or web sites in the 
sidebar.
https://addons.mozilla.org/en-US/fi refox/addon/1027
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 • Clear Cache Button
Adds a clear cache toolbar button. After installing the extension, fi nd the clear 
cache button in the toolbar customization area. Drag it onto your toolbar to make 
it available.
https://addons.mozilla.org/en-US/fi refox/addon/1801

 • Xiniah Here
Have a visual text editor at any time, even when one isn’t available.
https://addons.mozilla.org/en-US/fi refox/addon/1449

 • Foxmarks Bookmark Synchronizer
Install Foxmarks each computer you have Firefox installed on and it will work si-
lently in the background to keep your bookmarks synchronized across all comput-
ers. You can also log in to my.foxmarks.com to manage your bookmarks from any 
computer.
https://addons.mozilla.org/en-US/fi refox/addon/2410

 • PDF Download
PDF Download relieves the irritation experienced when encountering PDF fi les on 
the Web. Whenever you click on a PDF fi le, PDF Download lets you know before 
trying to open it, and then off ers you choices such as downloading, opening, or 
converting it straight to HTML. 
https://addons.mozilla.org/en-US/fi refox/addon/636ScribeFire

 • Zotero
Helps you collect, manage, and cite your research sources. Automatic capture of 
citation information from web pages. Stores PDFs, fi les, images, links, and whole 
web pages for access later. Visit www.zotero.org for full information and the quick 
start guide. 
https://addons.mozilla.org/en-US/fi refox/addon/3504

 • ScribeFire
ScribeFire is a full-featured blog editor that integrates with your browser and lets 
you easily post to your blog.
https://addons.mozilla.org/en-US/fi refox/addon/1730
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BASIC
Home:
http://www.mozilla.com/firefox/
Extensions & Themes:
https://addons.mozilla.org/
Support Forum:
http://forums.mozillazine.org/

GENERAL KEYBOARD SHORTCUTS 
Add Bookmarks Ctrl + D 
Bookmarks Ctrl + B
DOM Inspector Ctrl + Shift + I 
Downloads Ctrl + J 
Full Screen View F11
Help F1
History Ctrl + H 
Page Source Ctrl + U 
Print Ctrl + P 
Refresh Page F5
Refresh Page & Cache Ctrl + F5 
Save Page As Ctrl + S 

NAVIGATION KEYBOARD SHORTCUTS 
Back Alt + Left Arrow 
Down One Line Down
Down One Page PageDown
File Open Ctrl + O 
Forward Alt + Right Arrow 
Frame Next F6
Frame Previous Shift + F6 
Home Page Alt + Home 
Jump to Address Bar Ctrl + L 
Jump to Search Bar Ctrl + K 
Page Bottom End
Page Top Home
Stop Esc
Tab Close Ctrl + W 
Tab New Ctrl + T
Tab Next Ctrl + Tab 
Tab Previous Ctrl + Shift + Tab
Tab Select Ctrl + [1 - 9] 
Up One Line Up
Up One Page PageUp
Window Close Alt + F4 
Window New Ctrl + N 

TEXT KEYBOARD SHORTCUTS 
Copy Ctrl + C 
Cut Ctrl + X 
Delete Del
Text Size Decrease Ctrl + - 
Text Size Increase Ctrl + + 
Text Size Default Ctrl + 0 
Undo Ctrl + Z 

SEARCH KEYBOARD SHORTCUTS 
Find Again F3 
Find as You Type Link '
Find as You Type Text /
Find in This Page Ctrl + F 
Find Previous Shift + F3 

MOUSE SHORTCUTS 
Back Shift + Scroll Down
Forward Shift + Scroll Up 
Open Link in Background Tab Ctrl + Left Click or Middle Click
Open Link in Foreground Tab Ctrl + Shift + Left Click 
Open Link in New Window Shift + Left Click 
Scroll Line by Line Alt + Scroll 
Tab Close Middle Click on Tab 
Tab New Double Click on Tab Bar 
Text Size Decrease Ctrl + Scroll UP
Text Size Increase Ctrl + Scroll Down 

LOCATIONS
Cached Elements
C:\Documents and Settings\[username]\Local Settings\Application 
Data\Mozilla\Firefox\Profiles\[profilename]\Cache\
Profile Manager
Close Firefox. From the "Start" menu, select "Run", type "firefox.exe
-p"
User Profile Folder
C:\Documents and Settings\[username]\Application 
Data\Mozilla\Firefox\Profiles\xxxxxxxx.default\
Advanced Configuration
Address Bar: about:config 
Cache Info
Address Bar: about:cache
Plugin Info
Address Bar: about:plugins

TIPS/TRICKS
Block Popup Windows
Tools -> Options -> Web Features 
Customize Toolbars
Right click on a toolbar and chose customize toolbar. To add icons
drag and drop them on the toolbar. To subtract icons drag them from
the toolbar to the "Customize Toolbar" window. 
Desktop Shortcut to Current Page
Drag the icon in the address bar to the desktop 
Make Firefox Default Browser
Tools -> Options -> General -> Set Firefox As Default Browser
Manage Cache, Cookies, History and Passwords
Tools -> Options -> Privacy
Set Home Page 
Tools -> Options -> General -> Home Page 
Tabbed Browsing Options 
Tools -> Options -> Advanced -> Tabbed Browsing 

MOZILLA FIREFOX CHEAT SHEET

For use with Firefox running on a Windows machine. OS X users should use Cmd instead of Ctrl and Option instead of Alt. Based on the work of David 
Tenser. Last Updated: 06.21.06. 
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If you would like this... Type this...

Headings and Subheadings

Title
Heading
Subheading
Topic
Subtopic
Sub-subtopic

<h1>Title</h1>
<h2>Heading</h2>
<h3>Subhead</h3>
<h4>Topic</h4>
<h5>Subtopic</h5>
<h6>Sub-subtopic</h6>

Bold text
This text is bold This text is <strong>Bold</strong>

Italic text
This text is italicized This text is <em>italicized</em>

Line break
If you would like to break text into two 
lines without creating a new paragraph.

If you would like to break text into <br/>
two lines without creating a new paragraph.

Non-breaking space
There are three non-breaking   spaces 
here

There are three non-breaking 
&nbsp;&nbsp;&nbsp; spaces here.

Citing a reference
Gone with the Wind is a very long novel <cite>Gone with the Wind</cite> is a very long 

novel.

Bulleted list
• Item 1
• Item 2
• Item 3
• Item 4

<ul>
<li>Item 1</li>
<li>Item 2</li>
<li>Item 3</li>
<li>Item 4</li>
</ul>

Numbered lists
1. Item 1
2. Item 2
3. Item 3
4. Item 4

<ul>
<li>Item 1</li>
<li>Item 2</li>
<li>Item 3</li>
<li>Item 4</li>
</ul>
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If you would like this... Type this...

Indenting a block of text
Using blockquote tags will 
indent your text from both the 
left and right margins. Ideally 
is should be used for lengthy 
quotations.

<blockquote> Using blockquote tags will 
indent your text from both the left and right 
margins. Ideally is should be used for lengthy 
quotations.</blockquote>

Creating paragraphs with space before and after
When using Smart Text, Blackboard rec-
ognizes your carriage returns and adds a 
space between paragraphs.

HTML does not recognize carriage re-
turns; you must add paragraph marks.

<p>When using Smart Text, Blackboard recog-
nizes your carriage returns and adds a space 
between paragraphs.</p><p>HTML does not 
recognize carriage returns; you must add para-
graph marks</p>

Creating a link to another web page
The Center for Distance Education off ers 
many online courses.

The <a href=”http://www.distance.uaf.
edu”>Center for Distance Education</a> off ers 
many online courses.

(Note: To create your link, place the URL be-
tween the quotation marks.)

Making your link open in a new window - not in the Blackboard 
frame

The Center for Distance Education off ers 
many online courses.

The <a href=”http://www.distance.uaf.edu” 
target=”_new”>Center for Distance Educa-
tion</a> off ers many online courses.

(Note: To create your link, place the URL be-
tween the quotation marks.)

Making an email link
Please email your assignments to youre-
mail@uaf.edu when you  have fi nished 
them

Please email your assignments to 
<a href=”mailto:youremail@uaf.edu”> youre-
mail@uaf.edu</a> when you  have fi nished 
them

Linking an image
<img src=”http://pathtoyourimage.com/image.
jpg” alt=”The iTeach logo: />
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Personal Learning Environments

A Personal Learning Environment (PLE) is a combination of a philosophy of learning 
and communication facilitated and supported by a personalized collection of tools, 
techniques and resources. In today’s increasingly technologically connected (and 
sometimes co-dependent) educational environment, educators and students alike—
after all, teachers are themselves lifelong students--should pay some attention to their 
PLE… because each is creating one whether they realize it or not. 

The Philosophy: Information Fluency
 Underlying the operations and processes of the PLE is the concept of Information Flu-
ency (IF). Information Fluency is a model that builds on the skills of traditional digital 
literacy, integrating technology with domain (discipline) specifi c knowledge, critical 
thinking, presentation, participation and communication skills.

Domain Knowledge is the “stuff ” we teach. However, this is not limited to discipline 
specifi c information and facts, but also:

Personal Learning 
Environments



Personal Learning Environments

 • knowledge of information resources such as publications, databases, search 
tools, web resources, etc.

 • understanding of the community of learners, enthusiasts and professionals 
in that area

 • tools needed to browse, explore and discover needed information

 • methods for storing, managing, retrieving and sharing

Critical Thinking is something every educator thinks about and probably has a pet defi -
nition for. The intent with the Information Fluency model is that critical thinking is 
represented by the ability to:

 • analyze and evaluate information

 • conceptualize and integrate new learning 

 • analogize and create parallels

 • formulate and answer questions

 • use knowledge for problem-solving

 • think tangentially and orthogonally

Most important of all, to be complete critical thinking skills must involve paying attention 
to oneself and modifying one’s own behavior to improve understanding and ability.

Presentation and Participation represent a trend toward increased emphasis on learn-
ing community, both inside and outside the classroom. Presentation and participation 
include traditional activities, such as in-class presentations and readings, but also new 
activities and forums possible due to the aff ordances of technology, including partici-
pation in discussion boards, collaborative activities using tools like wikis and Voice-
Threads, blogging and participation in social networks.

Important characteristics of presentation and participation include:

 • the ability to create eff ective presentations designed for the specifi c audience 
using the appropriate media

 • comprehension of context, tone and basic rhetoric

 • knowledge to re-purpose information successfully for use in new contexts

 • a developed capacity for handling, evaluating and integration commentary 
and criticism from others

 • an understanding of the processes and value of self-refl ection  

These three core areas work together to create Information Fluency. As you can see, 
combinations that involve just 1 or 2 of the areas won’t really have the desired outcome:



Personal Learning Environments

 Information Fluency isn’t just a theoretical concept, but one which has practical ap-
plication throughout any course. It is a lens by which you can evaluate individual out-
comes, assessment and activities in your course and the course as a whole. 

In this diagram we have mapped some common activities, products and characteris-
tics of understanding to the Information Fluency triad. In real, messy world of actually 
developing a course and teaching these lines are often not nearly as explicit… a liter-
ally accurate diagram would look much like a cloud of electrons than these spoke and 
wheel simplifi cations: 
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The Tools and Techniques of the PLE
Information Fluency provides a model for educational activities; the Personal Learning 
Environment is the place where those activities happen. Just as learning activities and 
their products map to the three areas that comprise Information Fluency, those activi-
ties and their products can be mapped to diff erent tools and resources.

While each person will naturally evolve their own PLE, adding and discarding parts as 
needed, it can be useful to examine the tools and resources other people use. You can 
view a large collection of PLE Diagrams from an assortment of educators (and some 
students) on the EdTechPost wiki: http://edtechpost.wikispaces.com/PLE+Diagrams. 
I’ve selected a few to illustrate the diversity in tools, application and philosophy.

Alec Couros (http://educationaltechnology.ca/couros/) created this visualization as 
part of his PhD dissertation, illustrating the networked teacher. The resources Alec 
surrounds himself maybe facilitated technology, but include people, documents and 
media:

  Jared Stein (http://fl exknowlogy.learningfi eld.org/) attempted to capture some of 
the complexity of his PLE including some very specifi c items and not forgetting his 
hobbies and enthusiasms. Note that this kind of rendering looks more complex than 
it actually is, as simple behaviors can work themselves through the social network in 
various ways:
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 Jeremy Hiebert (http://headspacejblog.blogspot.com/) is quite interesting because he 
gets directly at what the network has allowed him to do in the past and will allow him 
to do in the future. The Collect, Connect, Refl ect, Publish cycle is important:
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 Finally, because these diagrams can seem a bit daunting, D’Arcy Norman 
(http://www.darcynorman.net/) boils the whole thing down to its essential: you + tools 
that let you learn from and work with smart people (and, I would add, smart resourc-
es):

 Getting Started
Keeping in mind the aforementioned “Collect, Refl ect, Connect, Publish” idea and the 
last simple, but eff ective, diagram, the question becomes: how do I get started? 

In fact, you have already started. Even before reading this you’ve used search engines 
and email, you’ve probably developed some method for storing information and links 
to use later, you’ve found ways to share interesting information with other people. 
In addition many of you will participate in some online discussions and have probably 
used social media such as YouTube. Here are some specifi c ways you can get started 
building up your own PLE during this workshop:



Personal Learning Environments

Collect

Many people make the mistake of considering the blog as a publishing tool to share 
with other people… but it is also a great place to store information that is of use to 
you. In fact, it might be best to consider most tools in your PLE (and most social tools 
in general: wikis, blogs, social bookmarking systems, etc) as utilities for your personal 
productivity fi rst and as a publishing mechanism second (if at all). Many of the network 
eff ects generated through one’s Personal Learning Environment come from “passive” 
activities that aren’t directly meant for or directed to other people, but feed into the 
ecosystem nonetheless.

For example, in the post below I have noted some resources for learning about the 
PLE. I’m collecting these fi rst and foremost for myself… but by collecting these re-
sources “out in the open” I am contributing something that may turn out to be useful 
to others, both inside the eLearn community and outside.

Refl ect

It is important that you have places to engage in refl ective activities. Again, the eLearn 
community provides tools for that. You can use your blog for this as well. By setting the 
appropriate privacy level you can, if you wish, limit your refl ections so that only other 
members of the eLearn community or even just yourself can see them. This last is par-
ticularly useful if you are a “write it down to know what I think” kind of person and your 
refl ections are intensely private or simply not ready for prime-time.

The eLearn community also allows you to create a group, which can be public or pri-
vate, moderated membership or open enrollment, where you can refl ect, discuss, 
share links, etc. For instance, here I have created—in just a few clicks—a group to 
discuss a particular topic in more depth and/or privacy than otherwise:
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Connect

You likely already have various ways to directly connect to others—email is perhaps 
the most common—but there are many ways to connect to colleagues locally and 
from around the globe. Connections are meaningless if they aren’t relevant, but they 
are perhaps the most powerful force in education when you fi nd the right one. Many 
people have a hard time fi nding “their” community. It can take a while, but remember 
that you are already the member of one community: eLearn, and also a much larger 
one that you may not have interacted with much: the group of educators improving 
and enhancing their educational eff orts with technology.

Connections aren’t made just by sharing information or providing a directed resource. A 
very important part of joining a community—or creating one—is informal interaction, par-
ticularly discussion and comments. It’s amazing how often one informal comment or 
one incidental resource shared out to the world can be the key to a profound change 
for someone else! Here I’m commenting on an article to share a resource that the origi-
nal poster—and anyone else reading that post—might fi nd useful:
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And remember… the eLearn community is just the beginning! An advantage of the 
socially networked age is the ability to learn from—and interact with—people with im-
mense amounts of talent and experience from just about everywhere. The quickest way 
I’ve found to join in these global conversations is to comment on their blogs, communi-
cate via Twitter, or share links with them. I’ve been fortunate enough to learn from many 
people this way who I never would have otherwise. For example, with Twitter:
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Publish

In a way, almost every use of social software such as blogs, wikis, and open discussion 
forums is a kind of publication. The simplest transformation engendered by new media 
is changing the publication process from one where most people had to choose be-
tween forcing their way through gatekeepers or having almost no reach to an egalitar-
ian system where global publication was in the hands of everyone (for better and for 
worse). In this environment words matter more than who you know and the scope and 
duration of the publication is practically unlimited. And in the educational sphere the 
size of one’s audience is much less important than their suitability—the right 10 readers 
are worth 1000 idle passers-by, and your words—at that moment they need them—
worth any number of irrelevant publications with more readers.
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The ISTE  
National Educational Technology Standards (NETS•T)  

and Performance Indicators for Teachers
Effective teachers model and apply the National Educational Technology Standards for Students (NETS•S) as they design, implement, 
and assess learning experiences to engage students and improve learning; enrich professional practice; and provide positive models for 
students, colleagues, and the community. All teachers should meet the following standards and performance indicators. Teachers: 

1.  Facilitate and Inspire Student Learning and Creativity
 Teachers use their knowledge of subject matter, teaching and learning, and technology to facilitate experiences that advance student   
 learning, creativity, and innovation in both face-to-face and virtual environments. Teachers:

  a. promote, support, and model creative and innovative thinking and inventiveness 
  b. engage students in exploring real-world issues and solving authentic problems using digital tools and resources 
  c. promote student reflection using collaborative tools to reveal and clarify students’ conceptual understanding and thinking, planning,   
   and creative processes
  d. model collaborative knowledge construction by engaging in learning with students, colleagues, and others in face-to-face and virtual   
   environments

2.  Design and Develop Digital-Age Learning Experiences and Assessments
 Teachers design, develop, and evaluate authentic learning experiences and assessments incorporating contemporary tools and resources to   
 maximize content learning in context and to develop the knowledge, skills, and attitudes identified in the NETS•S. Teachers: 

  a. design or adapt relevant learning experiences that incorporate digital tools and resources to promote student learning and creativity 
  b. develop technology-enriched learning environments that enable all students to pursue their individual curiosities and become    
   active participants in setting their own educational goals, managing their own learning, and assessing their own progress
  c. customize and personalize learning activities to address students’ diverse learning styles, working strategies, and abilities using   
   digital tools and resources 
  d. provide students with multiple and varied formative and summative assessments aligned with content and technology    
   standards and use resulting data to inform learning and teaching

3.  Model Digital-Age Work and Learning
 Teachers exhibit knowledge, skills, and work processes representative of an innovative professional in a global and digital society. Teachers:

  a. demonstrate fluency in technology systems and the transfer of current knowledge to new technologies and situations
  b. collaborate with students, peers, parents, and community members using digital tools and resources to support student success   
   and innovation 
  c. communicate relevant information and ideas effectively to students, parents, and peers using a variety of digital-age media and formats
  d. model and facilitate effective use of current and emerging digital tools to locate, analyze, evaluate, and use information    
   resources to support research and learning 

 4.  Promote and Model Digital Citizenship and Responsibility 
 Teachers understand local and global societal issues and responsibilities in an evolving digital culture and exhibit legal and ethical   
 behavior in their professional practices. Teachers:

  a. advocate, model, and teach safe, legal, and ethical use of digital information and technology, including respect for copyright,    
   intellectual property, and the appropriate documentation of sources 
  b. address the diverse needs of all learners by using learner-centered strategies and providing equitable access to appropriate digital tools   
   and resources 
  c. promote and model digital etiquette and responsible social interactions related to the use of technology and information
  d. develop and model cultural understanding and global awareness by engaging with colleagues and students of other cultures using  
   digital-age communication and collaboration tools 

5.  Engage in Professional Growth and Leadership
 Teachers continuously improve their professional practice, model lifelong learning, and exhibit leadership in their school and professional  
 community by promoting and demonstrating the effective use of digital tools and resources. Teachers: 

  a. participate in local and global learning communities to explore creative applications of technology to improve student learning 
  b. exhibit leadership by demonstrating a vision of technology infusion, participating in shared decision making and community    
   building, and developing the leadership and technology skills of others 
  c. evaluate and reflect on current research and professional practice on a regular basis to make effective use of existing and emerging digital  
   tools and resources in support of student learning 
  d. contribute to the effectiveness, vitality, and self-renewal of the teaching profession and of their school and community

Copyright © 2008, ISTE (International Society for Technology in Education), 1.800.336.5191 (U.S. & Canada) or 1.541.302.3777 (Int’l), iste@iste.org, www.iste.org. All rights reserved.
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Introduction

Agree or Disagree?
“Teaching and learning are two sides of the same coin.”

Understanding by Design provides a fl exible framework for the pragmatic develop-
ment of online courses. Of all the material we have reviewed, we believe this method 
best serves our purposes for the thoughtful design of curriculum.

Using a “reverse engineering” approach, we will explore the desired outcomes for 
your course, and then work backward to create a rich learning experience for your 
students. Along the way, we’ll talk about “understanding” - what it really means and 
how you’ll recognize when your students achieve it.

Credits and Sources
Our primary resource for this method is the 2nd edition of Understanding by Design, 
written by Grant Wiggins and Jay McTighe. We’ve provided a copy in your packet of 
materials. A workbook is available by the same authors; from this workbook we’ve 
chosen a handful of worksheets that we fi nd particularly useful. We’ve secured reprint 
permission and included copies in your binder. While the binder as a whole is licensed 
under Creative Commons - and free for you to share with others simply by giving at-
tribution - the pages from Understanding by Design and the accompanying workbook 
are copyright protected.
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3-Minute Response
What do students want to know when they come to your class?

What do they need to know?

What do students always get stuck on?

Write one thing that students need to understand before 
they go on to the next level (i.e., the next course in the disci-
pline):
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User:Jbmurray/Madness
From Wikipedia, the free encyclopedia
< User:Jbmurray

This is an essay; it contains the advice and/or opinions of one or more
Wikipedia contributors. It is not a policy or guideline, and editors are not
obliged to follow it.

Please update the page as needed, or discuss it on the talk page.

Was introducing Wikipedia to the classroom an act of madness leading only to mayhem if not murder?

Reflections on the use of Wikipedia in the University of British Columbia's course SPAN312, "Murder,
Madness, and Mayhem: Latin American Literature in Translation," Spring 2008.

Contents

1 Wikipedia: unloved but ubiquitous in academia
2 Assignment: to create a featured article
3 Initial considerations: the advantages of wikipedia
4 Initial considerations: potential pitfalls
5 First steps: "our" project begins
6 First lesson: "this may be deleted"
7 The FA-Team: synergy, good and bad
8 Research: and then research again
9 Other observations: a professional piece of work
10 Pointless? No argument
11 Notes

Wikipedia: unloved but ubiquitous in academia

At present, wikipedia hovers at the fringes of academia, like an uninvited guest. Wikipedia's aims are
eminently academic, concerned with collecting, processing, storing, and transmitting knowledge. Judging by
the number of the site's articles and readers (http://www.alexa.com/data/details/traffic_details/wikipedia.org) ,
it has been remarkably successful at promoting a culture of intellectual inquiry. Yet it is fairly consistently
derided by academics themselves.

Still, everybody uses it, in one way or another, even if they might want not to admit to the fact. Above all, our
students use it, openly or otherwise (as they are often explicitly told not to cite wikipedia article in term

Case Study 1
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papers), but without necessarily knowing how it works. They are told that wikipedia is bad, but they are not
often told why; and of course, they find it an incredibly useful resource.

Assignment: to create a featured article

I decided to include wikipedia as a central part of a course I was teaching in the belief that it was only by
actively contributing to the encyclopedia that students would learn about its weaknesses, as well as its
strengths. And also with the idea that they would thereby, and perhaps rather incidentally, improve articles in a
field (Latin American literature) in which in my experience wikipedia has been especially weak.

Wikipedia was to occupy a central part of the course, but it was not to be the centre itself. This was not a
course about wikipedia but rather, as with my other courses, its focus would continue to be on Latin America
and on the reading of a set number of Latin American literary texts. In this case, a course entitled "Murder,
Madness, and Mayhem," these texts were a series of dictator novels, by authors ranging from the nineteenth-
century Argentine Domingo Sarmiento to the contemporary stars of Latin American letters, Gabriel García
Márquez and Mario Vargas Llosa. These books are neither short nor simple; most of the students' time would
be spent reading these hefty tomes, and most of the class time spent explaining and discussing them.

So there was little direct discussion of wikipedia in the classroom. Rather, the assignment was that, in groups,
the students should edit (and in a couple of cases create) wikipedia articles on the texts and authors that we
were covering, and that over the course of the semester they should bring these articles up to what in wikipedia
parlance is called "featured article" status.

When setting that assignment, I had not really comprehended how ambitious it was. Wikipedia defines a
"featured article" as an article that "exemplifies [its] very best work and features professional standards of
writing and presentation." And its standards are, in fact, impressively high. Indeed, it is a central paradox of
wikipedia that its standards are impeccable, even as its actual performance so often lags far behind these
standards. To give some indication: fewer than 0.1% of wikipedia's articles are featured articles.

Indeed, as far as I can tell, while wikipedia has been the subject of numerous educational assignments, from
universities as far apart as Sydney, Hong Kong, Minnesota, and Leiden, this would be the first time in which
students were explicitly asked to create featured articles.

Initial considerations: the advantages of wikipedia

In addition to teaching (somewhat indirectly) students the weaknesses as well as benefits of wikipedia, as well
as (perhaps incidentally) improving the encyclopedia's coverage of Latin American issues, there were other,
more positive, reasons justifying my choice of assignment.

I liked the idea that students would be engaging in a real world project, with tangible and public, if not
necessarily permanent, effects. In the end, an essay or an exam is an instance of busywork: usually written in
haste; for one particular reader, the professor; and thereafter discarded.

It is a lamentable fact that, with rare exceptions such as in the Composition classroom, students are seldom
motivated to re-read and reflect upon their own work. Indeed, they often scarcely even glance at the comments
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professors laboriously write up on their work: understandably given that there is usually by this stage no
chance to change things further, they are interested in the grade, and that is it. Students seldom learn about the
importance of revision to good writing. And yet on wikipedia, revision is (almost) everything: contributors are
called editors precisely because their writing is a near-constant state of revision.

Moreover, here they would be contributing to pages that in some instances (the article on Gabriel García
Márquez, for instance) received over 60,000 page views per month. Even the least visited articles they were
writing receive several hundred monthly visits. Here they would be writing for a public audience, also one that
almost uniquely was in a position to write back, to re-write and comment upon what they were writing.
Indeed, working on wikipedia had the potential to become a collaborative process: students would have to
collaborate not only with each other, but also with fellow editors or wikipedians who they met only on the
wiki itself.

Finally, I liked the notion that the grade that they would receive for this assignment would come from outside
the class itself; that their work would be judged by its external impact, and not by the professor's personal
judgement (however professional that might be). I declared from the outset that a group that turned its article
into a "featured article" would receive an A+, no questions asked; and that groups that achieved "good article"
status (a lower hurdle, though good articles still account for only about 0.15% of wikipedia's total) would
receive an A. The assignment grade, in other words, would be determined by collective, public, peer review.

Initial considerations: potential pitfalls

I have to admit that I had not really considered too many possible pitfalls to the plan. I recognized it was a bit
of an experiment, but was happy to give it a go. In any case, this was not the course's sole assignment or
method of evaluation: students would also have to write weekly blogs
(http://posthegemony.blogspot.com/2008/01/span312.html) on their reading; there was a midterm; and also a
final paper.

(Later in fact I dispensed with the final paper, but only after a secret and anonymous ballot among all the
students, for which I said that change would only be made if two-thirds of the class agreed; in the end 85%
voted in favor of scrapping the final paper and so expanding the role given to wikipedia in the final
assessment.)

My one fear was that students might end up in unconstructive and even perhaps discouraging edit wars. An
edit war is, in essence, a pushme-pullyou debate between editors who cannot agree as to what should be in an
article. Quickly, as elsewhere in online interactions, such disagreements can become bad-tempered and
provoke the intervention of wikipedia administrators who may decide to "block" one or both of the offending
individuals. I knew this all too well as, in an exploratory foray on wikipedia a few months prior to the class, I
had found myself (usually inadvertently) caught up in such wars, and had even once been blocked for a while.

There is always a danger to allowing students to interface directly with the public sphere. And we have a duty
of care to them in some way, which is perhaps why so much educational technology (above all WebCT) is
sealed off from the "real world." Plus it would hardly be productive were one of my students prevented from
continuing his or her assignment thanks to a wikipedia block! I crossed my fingers and hoped that this
eventuality would not occur.
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First steps: "our" project begins

I was not a complete newbie to wikipedia; indeed, I had made a number of edits and created several articles,
though these were mostly what are called "stubs," that is short, preliminary versions of articles. I had not really
previously worked in sustained fashion on a wikipedia article. But I felt I more or less knew my way around,
and had a sense of wikipedia culture, even though I was (and to be honest often still am) baffled by some of
the more arcane technical and procedural details in what is by now a labyrinthine behemoth of an enterprise.

On the other hand, therefore, I felt I could sympathize with the students' likely sense of intimidation at the task
before them. Only one or two students had ever edited wikipedia before. Few showed much sign of particular
sophistication with web markup and the like, let alone wikipedia's special (albeit simplified) brand of code. I
felt I could appreciate their mystification when, having probably for the first time clicked the button marked
"edit this page" that is the hallmark of wiki software, they came across a confusing mass of indecipherable
squiggles.

To establish some kind of framework, and to seek support, I registered the project at a wikipedia page
dedicated to such things, indicated on each article included within the project that it was part of an educational
assignment, and constructed a "project page" outlining our goals. I also left messages at various other related
wikipedia projects (which are basically groups of wikipedia editors who focus on a particular topic such as
literature or South America), even dropped a note at the encyclopedia's in-house newspaper, the Wikipedia
Signpost, announced the project in class, asked students to register an account with wikipedia, and more or
less sat back and hoped for the best.

You may notice that I have been talking about "our" project and "our" goals. I usually try to use such inclusive
language in class: "we" are reading the texts "together"; "we" are trying to figure out how to interpret them.
But here the sensation was quite palpable: from quite early on I felt that I was on the line also with this project;
and this feeling would only grow stronger in subsequent weeks.

First lesson: "this may be deleted"

Early on in the semester, at a point by which everyone had now been expected to register and begin
experimenting with editing, I brought my computer to class and went through some of the basics. Hooked up
to a projection unit, I showed the students on the big screen where the "edit" tab was, how to make a minor
edit (I changed one word (http://en.wikipedia.org/w/index.php?
title=University_of_British_Columbia&diff=prev&oldid=184559766) on our own university's wikipedia
article), and how to make a more major edit (I stubified (http://en.wikipedia.org/w/index.php?
title=Great_Northern_Way_Campus&diff=prev&oldid=184561202) the page of an article associated with the
university, which was manifestly plagiarized from an external website).

Then one student asked me to show them how to create a new page. Two of the articles they were working on
did not exist at the outset, so I created one of them: El Señor Presidente, which started off
(http://en.wikipedia.org/w/index.php?title=The_President_%28novel%29&oldid=184563569) containing as its
sole text "El Señor Presidente is the title of a novel by Miguel Ángel Asturias." I then moved on to some other
page, before coming back to the new page just a couple of minutes later... and this was the first lesson. For I
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discovered to some embarrassment (and in front of the entire class) that within sixty seconds some other
wikipedia editor had already pasted a huge pink banner (http://en.wikipedia.org/w/index.php?
title=The_President_%28novel%29&direction=next&oldid=184563696) on our freshly-minted page that said
"This page may meet Wikipedia’s criteria for speedy deletion." "The bastards!" I said under my breath, and
proceeded hurriedly to change the article's content to "El Señor Presidente is the title of the most important
novel by Nobel-prize-winning novelist Miguel Ángel Asturias," anxious that our little project would not be
sunk before it had barely begun.

But of course if I had actively wanted to teach the students that editing wikipedia was an exercise in
negotiating with an entire community of fellow readers and editors, I could hardly have chosen a better way to
do it. I have discovered (since) that for other educational assignments on wikipedia, often students have been
encouraged to draft their articles away from the public gaze, and to upload them to the encyclopedia's public
pages only once they were ready for general scrutiny. Here everything has been open and exposed from the
start. But I don't regret this in the slightest. Indeed, it has allowed, I think, for some of the project's greatest
strengths...

The FA-Team: synergy, good and bad

For it was not long before we stumbled across our first, and by far the most important, piece of good luck.
Though nothing came of my messages to the various pre-existing wikipedia projects (most of which, as far as
I can see, are defunct or, more likely, simply overwhelmed), it so happened that a small group of experienced
wikipedia editors had apparently been kicking around ideas as to how best to increase the number of featured
articles on the encyclopedia. They were calling themselves the "FA-Team" and they were looking for a project
to work on. They found us, and wrote to see if we would like any help.

Would we like any help? Absolutely!

The FA-Team divided up the project's articles between themselves, wrote welcome messages on each of the
students' user pages (which are personal pages assigned to every registered user of wikipedia, functioning as
places where editors can talk directly to each other), and embarked on an ongoing task of encouraging,
mentoring, and guiding all of us in the process of editing wikipedia articles to a high standard. These were
(and are) a very meticulous, dedicated, and above all generous bunch of people.

And the FA-Team manifested what is, I now realize, the greatest strength (if also perhaps the greatest
weakness) of wikipedia: synergy. Wikipedia editors are attracted to activity. Moreover, they are particularly
attracted to activity that involves the input of new content to the encyclopedia. A case in point is the flag that I
had received upon creating a new page: there is a whole cadre of wikipedia volunteers who keep their eyes
tirelessly on page creations, ready to pounce should an inappropriate or unencyclopedic topic be proposed.
Anyone can create a page on wikipedia, but if you create one about yourself, your garage band, or your cat, it
is likely to be deleted at lightning speed.

Equally, though many (most notably perhaps, the US comedian Stephen Colbert
(http://www.powerpage.org/2006/08/stephen_colbert_v_wikipedia.html) ) have criticized wikipedia for the fact
that anybody can add nonsensical content to any article, they most likely do not realize that there are squads of
dedicated wikipedians watching recent changes to the encyclopedia, who will swiftly eliminate patent rubbish.
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But the more constructive side to this rapid-response aspect of wikipedia also revealed itself when, within a
couple of days of my creating El Señor Presidente, a whole number of other editors had made minor but
collectively significant formatting changes. A student then added a snippet of content that they had found on
another website. More formatting followed. So that by the very next class, that article now looked
(http://en.wikipedia.org/w/index.php?title=The_President_%28novel%29&oldid=185101382) like most other
wikipedia pages: a little on the short side, rather incomplete, with a couple of half-random internet sources, but
informing its reader at least minimally about its topic; and now integrated into the greater wikipedia enterprise.

(I should note that I was not much concerned if the final product of the students' assignment was not "all their
own work"; I considered that persuading others to work with them, and working well with others, was an
integral part of the operation. Of course, one could imagine somebody cheating in this assignment, as in any
other: for instance by paying some third party to write the article for them. But in general, in fact, the wiki
software, which tracks each user's contributions, allows for unrivalled transparency as to what students are
doing, step by step, and how much, and when.)

In a sense, then, the FA-Team's intervention was not exceptional. It was simply a broader and rather more
developed instance of this same principle of synergy, of the fact that the more you add to wikipedia, the more
your activity resonates and is developed and multiplied by the activities of others. Yes, there are edit wars; but
in my experience these do not on the whole revolve around the addition of new content. We had not simply
struck lucky; we'd come across one of the basic principles of the wiki's operation.

The downside of this principle is that where wikipedia is moribund, it stays moribund. Though in theory
wikipedia is an endless hive of activity, in practice a glance at the histories of a few pages (all of which are
easily available for consultation, at the click of a few more tabs) demonstrates that they are in fact remarkably
stable. A bad article remains a bad article for a long, long time. To take a couple of instances from this project
of older (and so in fact more important) topics: the entries for Gabriel García Márquez and Mario Vargas Llosa
have scarcely moved for years, bar a tweak here and a tweak there. Our job was to change this.

Research: and then research again

This was, then, a research assignment. The students' task was to find what in wikipedia jargon are termed
"reliable sources." One of the encyclopedia's fundamental (if, to an academic's ears, peculiarly named) tenets is
that there should be "no original research." What is meant by this in fact is that an encyclopedia entry should
not be the place to develop an argument. This is the most fundamental difference between a more traditional
essay assignment and wikipedia.

As the FA-Team had taken it upon themselves to supervise issues of formatting and procedure, students were
freed up to devote themselves to research. Here, however, lay another unexpected pitfall, though it perhaps
should not have been so very unexpected as its cause lay at the very heart of the wikipedia assignment. Indeed,
the assignment itself was aimed directly at the very problem that has perhaps most stymied it: the fact that
students fail sufficiently to evaluate their sources.

For after all, the premise of the project was that students had been using wikipedia as a source without
properly considering its drawbacks. So it should have come as no surprise then that when seeking sources for
the articles they were writing, again all too often they should make the same mistakes. They would add
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information that was unsourced, poorly referenced (and too frequently even plagiarized), or cited from what
were often enough merely other webpages and online encyclopedias.

Yet here lay also one of the great benefits of the assignment. Precisely because of wikipedia's injunction (oft-
repeated by the various members of the FA-team) that every item in their article had to be referenced, students
were forced to reveal their sources. These poor sources came to light in a way that they might well not have
were they writing a term paper. Moreover, precisely because writing on wikipedia is a process of continual
revision, they could be asked to go back and re-evaluate their sources, find better ones, and try again. Even
with plagiarism, there was no longer the need to make a song and dance about it, because at no time were they
handing in what purported to be a final product.

In short, the assignment is bringing out the weaknesses in students' research skills, but then those weaknesses
are its very presupposition. However, it is also teaching them those skills, teaching them that research (like
writing) is a process, often a lengthy one, whereby you might start with suboptimal sources (such indeed as
wikipedia itself) but then progress to look for ever better evidence for the information at hand, or for new
information that those first sources do not necessarily reveal.

Other observations: a professional piece of work

I'm writing this in what is still the throes of the project. One article, perhaps ironically the very one that I
started in class, has passed its first formal, and I should say remarkably stringent, peer review hurdle and so
has been named a "good article." My students have therefore already created, and created from scratch, part of
Wikipedia's best 0.15% content. Moreover, there are no other Latin American literary works among that
0.15%. So they have contributed what is now the very best Wikipedia article on any work of Latin American
literature. They (we?) can be rightly proud.[1]

As far as I am aware, this is the only educational assignment on Wikipedia ever to have directly contributed a
"good article."[2]

Of course, not everything has been plain sailing. A couple of the articles have not so far progressed very much
at all. The dream of creating twelve new featured articles will remain, most likely, but a dream. (Though
imagine: it would mean that the entire class would be awarded an A+ for what is now 40% of the course
assessment.) But I am confident that we will emerge with a spate of other good articles (two others are
currently up for review), some of which will be nominated at least for featured article status. That is a rigorous
test; this is far from being an easy option of an assignment just because it takes place on that much reviled
beast of a website, Wikipedia. If anything, quite the reverse.

And I am still far from starry-eyed about Wikipedia. Again, imagine an encyclopedia in which only a small
fraction of one per cent of the entries are what even its own editors categorize as "good." Other of Wikipedia's
weaknesses are also more apparent than ever, and even to some extent replicated within this project: the
tendency for what is already moribund to remain that way; and the reliance upon weak sources, often
plagiarized.

But in favour of Wikipedia, I should say that I had not previously realized how high its own standards are,
how rigorously they are applied, as well as how well its synergistic processes can work... if you are prepared
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to contribute your own activity and, above all, do the requisite research to add properly sourced content.
Again, I should also mention that we have been very fortunate with the particular individuals that we have
come across; though I suspect that that fortune is likely to be encountered by others, too.

As for the assignment, which is again far from over... I'd like to think that it is teaching the students research
skills and writing skills in what is very much a real world environment. They were set a medium- to long-term
goal at the beginning of the semester, and were required to work collaboratively both within their own groups
and with strangers in the public domain to plan how to achieve and deliver that goal. And their final product is
to be a professional piece of work that will be viewed by many thousands of people, a resource that is in most
cases the first port of call for future researchers, whether students like themselves or any of the many millions
from all over the world who visit Wikipedia. Most of these articles are, after all, the top hit (or very close to it)
in any internet search of the topic.

By comparison, the usual essays and exams that we assign our students really are rather pointless busywork.

Pointless? No argument

The one skill that this project does not teach the students is how to construct an argument. And of course,
argumentation, the development of a coherent series of points, the production and defence of a cogent thesis,
is indeed at the core of the academic enterprise. I value that skill very highly.

But one could argue that for most of the occupations that most of these students will be entering after they
finish their time in academia, argumentation is not in fact so important as it is in the academy itself.
Information gathering, presentation, meticulousness, teamwork, and the ability to negotiate with the public
sphere are (I hesitate perhaps to admit) much more useful to them.

Moreover, writing wikipedia does instill critical thinking, if not of the variety that is usually most explicitly
addressed at university--though perhaps it should be. Wikipedia's editors are endlessly encouraged to think
critically about the information that they come across, and also about their own writing and self-presentation.

I worry a little that I have praised this assignment too much. I would do it differently if (when) I do it again. I
should certainly admit that I have often felt that it's been something of a high-wire act, in which anything
might go wrong at any minute. It still may do so. In which case, I can always go back and edit this text...

Oh, and in the meantime please feel free to help out at Murder, Madness, and Mayhem!

(First draft, March 18, 2008)

Notes

1. ^ On April 10, El Señor Presidente became Wikipedia's 2000th Featured Article. This article will be on Wikipedia's
main page on May 5. And by the end of the project, the students had brought two further articles up to Featured
standard (Mario Vargas Llosa and The General in His Labyrinth, plus another eight to Good Article standard. The
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only other Latin American literary topics at this standard are Mário de Andrade and Jorge Luis Borges (though
probably neither of these would make the grade now; it's notable that in fact Wikipedia's standards are steadily rising
over time). So we have effected an exponential increase in the number of quality articles about Latin American
culture.

2. ^ See the clarification here.

Retrieved from "http://en.wikipedia.org/wiki/User:Jbmurray/Madness"
Categories: User essays

This page was last modified on 29 April 2008, at 02:55.
All text is available under the terms of the GNU Free Documentation License. (See Copyrights for
details.) 
Wikipedia® is a registered trademark of the Wikimedia Foundation, Inc., a U.S. registered 501(c)(3)
tax-deductible nonprofit charity.
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“Doing something correctly proves that you 
understand what you are doing.”

Agree or Disagree?



Assessment

1-Minute Response
What is Understanding?
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Lesson 1 Assignment:

All problems are Set II exercises.  Please complete these problems along with the additional

questions on separate paper and submit with a lesson cover sheet.  Also submit your Personal

Information Sheet with this assignment.

Section 1.1: 4, 10, 14, 18, 22

Section 1.2: 6, 12, 18, 20, 24

Section 1.3: 8, 22, 28, 38, 48

Section 1.4: 10, 16, 30, 42, 46

Section 1.5: 14, 20, 26, 32, 38

Section 1.6: 4, 12, 18, 26, 42

Additional Questions:

1.  What concepts, if any, seemed new to you?

2.  What concepts were most difficult in this lesson?

3.  Which problems would you have liked to have seen more of?

Case Study 3: DEVM F060
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Assessment Map: 
Brainstorming
Assessment Type Instructor 

Effort
Student 
Effort
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Assessment Map: 
Your Course
Big Ideas Assessment Type Public/Private

Important to Know and Do Assessment Type Public/Private

Worth Being Familiar With Assessment Type Public/Private
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One way to create an assessment is to use the Add Assignment feature in Blackboard 
Using this features gives the student an easy way to submit assessments that doesn’t 
involve accessing the digital dropbox or relying on an instructor’s email. Instructors 
pose a problem (and attach additional fi les if necessary) and then gives the student the 
opportunity to complete the assignment and attached a separate fi le and send it back 
to the instructor. There is space available for comments for both instructor and stu-
dent. An entry in the gradebook is automatically created. Instructors will then grade 
the assignment from within the gradebook and be able to post a grade and provide 
feedback all in one place.

1. Within your Course Content area, select “Assignment” from the Select drop-down 
menu (right side of window).

a. Name the assignment: This is the name that will also 
appear in the grade center

b. Enter the points possible for the item: this will appear 
in the grade center

c. Enter the due date. This will appear in the student’s 
view of the gradebook.

d. Enter any instructions for completing the assignment.

e. Select available options

f. Attach additional fi les, if necessary. You might be able to give enough infor-
mation in the instructions area without having to attach additional fi les.

2. When your students go to submit their assignment, they can make comments 
about the assignment and then attach their fi le(s) to complete the assignment. Stu-
dents are also given the option to save the assignment or submit the assignment. The 
submit button must be selected in order to send the assignment to the instructor. 
Once an assignment is submitted it can not be resubmitted unless the instructor clears 
the attempt (through the gradebook).

3. Its always a good idea to provide some explanation for your students about how 
to use the assignment feature for those who may not have used it before.  Something 
like:

Complete this assignment by creating a document using [enter soft-
ware of your choice, i.e., microsoft word or some other word pro-
cessing program or program related to your course] and be sure to 
save your fi le as [.rtf, .doc, or whatever your preference is]. It would 
also be helpful to me if you include your last name in the fi le name so 

Add Assignment Feature
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I don’t get the fi les mixed up. When you have completed the assign-
ment and you’re ready to submit it, click on the View/Complete link 
below. Use the “Browse” button to look on your computer for your 
document and upload it to this online assignment. Share any com-
ments you have for me in the “Comments” fi eld. Finally click on the 
“Submit” button to complete the assignment. The “Save” button 
will only save it so that you can come back to it at a later time.

4. Since Add Assignment is tied into the instructor’s grade center, the instructor can 
see when a student submits the assignment when an exclamation point (!) appears in 
the student’s column in the grade center. The instructor can then download the fi le(s), 
grade it and send it back with additional feedback to the student. There is also a place 
to add comments that will only be seen by the instructor or TA and are not seen by the 
student that stay in the gradebook.

5. You can review student’s assignments one at a time or in a mass download by going 
to the grade center and by clicking on double-down arrows by the Assignment column 
header. Then select Assignment File Download and select which fi les you want to review. 
What will happen now is that Blackboard will create a zipped fi le (from all the separate 
student fi les) that you’ll download to your desktop. The original fi les will always re-
main on the Blackboard server. Save this zipped fi le to your desktop and then double-
click on it to open it. It will create a  new folder with all the separated fi les listed inside 
of it. (Comments made by the student will also appear in this folder as separate text 
fi les). When the assignment has been graded, the student can go back into the As-
signment, review the assigned grade and see the Instructor’s feedback or access the 
feedback through their gradebook.
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There are two types of assessments to create in Blackboard: 

Survey: The survey option creates assessments that record answers anonymously. 
Use this when you want to perform opinion polls or course evaluations. Survey re-
sults are non-graded and anonymous. 

Quiz/Test: In the quiz/test option, you can assign point values to each question. Stu-
dent answers can be submitted for grading, and the results are recorded under each 
student entry in the gradebook. 

1. Log into Blackboard. 

2. Go to your course area. 

3. Go to your Control Panel. 

4. Click Test Manager or Survey Manger under Assessments. For this example we’ll 
select Test Manager. Notice that you are able to click on the yellow triangles on the 
columns  to have alternative sorting options.

5. You will see Add Test on the left side Click here and you will be presented with 
the a new test screen. 

6. Enter a name and description for your assessment. Note that the description is 
what will show up in both the content area and when a student enters the assess-
ment. The Instructions will only show when a student enters the assessment.

7. Click the Submit button.  

8. The next screen asks you about the type of question you wish to ask your stu-
dent. Click the down arrow in the text box to see what question types are available. 

9. The link called Creation Settings gives you options for your test questions. Things 
like including images, fi les or external links to questions or answers, specifying ran-
dom ordering of answers, and specifying partial credit for answers are examples. 

10. Choose your question type and Click the Go button. Questions types include:

 • Calculated Formula Questions

 A Calculated Formula question contains a formula, the variables of which can be 
set to change for each user. The variable range is created by specifying a mini-
mum value and a maximum value for each variable. Answer sets are randomly 
generated. The correct answer can be a specifi c value or a range of values. 
Partial credit may be granted for answers falling in a range.

 • Calculated Numeric Response Questions

 This question resembles a fi ll-in-the-blank question. The user enters a number to 
complete a statement. The correct answer can be a specifi c number or within a 
range of numbers.

Creating Tests/Quizzes/
Surveys
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 • File response questions

 Users upload a fi le as the answer to the question. This type of question is 
graded manually.

 • Hot spot questions

 Users indicate the answer by marking a specifi c point on an image. A range of 
pixel coordinates is used to defi ne the correct answer. Hot Spot refers to the 
area of an image that, when selected, yields a correct answer.

 • Fill in Multiple Blank Questions

 This question type builds on fi ll-in-the-blank questions with multiple fi ll in the 
blank responses that can be inserted into a sentence or paragraph. Separate 
sets of answers are defi ned for each blank.

 • Jumbled Sentence Questions

 Users are shown a sentence with a few parts of the sentence as variables. The 
user selects the proper answer for each variable from drop-down lists to as-
semble the sentence. Only one set of answers is used for all of the drop-down 
lists.

 • Opinion Scale / Likert Questions

 Question type based on a rating scale designed to measure attitudes or reac-
tions. Users indicate the multiple choice answer that represents their attitude 
or reaction. When the instructor creates an opinion scale question, six answer 
fi elds are pre-populated with the following answers: Strongly Agree/Agree/Nei-
ther Agree nor Disagree/Disagree/Strongly Disagree/Not Applicable

 • Short Answer Questions

 Short Answer questions are similar to essay questions. The length of the answer 
can be limited to a specifi ed number of rows in the text box. The number of 
rows is meant as a guideline when entering an answer, it does not impose an 
absolute limit on answer length

 • Either/Or questions

 Users are presented with a statement and asked to respond using a selection 
of pre-defi ned two-choice answers, such as: Yes/No, Agree/Disagree, or Right/
Wrong

 • Quiz Bowl Questions

 The user is shown the answer and responds by entering the correct question 
into a text box. An answer must include a phrase and a question word, such as 
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who, what, or where, to be marked as correct. Partial credit may be given if the 
question word is not included in the answer.

11. The type of text boxes you get next will depend on your question type. 

12. Enter the information for your question. 

13. In the response boxes, you can enter information that will be displayed after the 
student submits his/her answers, such as on which page of the text to fi nd the correct 
answer or other feedback information. 

14. Use Add New Question to add another question to your assessment or Click on 
OK to complete the assessment. 

15. When you are ready to place the assessment within your content area, click on the 
Add Test link in the Blackboard menu bar. This gives you the opportunity to either 
create a new assessment or to make a selection from the assessments that you have 
already created. Click OK 

16. You then have the option to Modify the Test or to Modify the Test Options. If 
you need to make changes to test questions, select the fi rst option. If you’re ready 
to make the test available for students then select Modify the Test Options. Here you 
will be presented with the opportunity to determine how many attempts at the test 
the students will have, you can set a timer or a password for security purposes, and 
you’ll be able to defi ne how feedback will be shown. Other options include making 
the quiz available, dates of availability, whether you want to make an announcement 
(so it will show up in the Announcements list when students log on), where to place 
the link, and various other options. 

17. Make your selections. 

18. Click the Submit button.
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Instructors may import fi les containing questions into an Assessment or question pool.

Files for Test Manager 
Follow the instructions below for uploading questions into Tests. The formatting for im-
porting into Question Pools is diff erent. The questions in the uploaded fi le must match 
the fi le structure explained below. The fi le may include Essay, Ordering, Matching, Fill 
in the Blank, Multiple Choice, Multiple Answer, and True/False questions. There is also 
an online Test Generator available at http://www.byui.edu/onlinelearning/employees/
testgen/index.htm that you might fi nd much easier to use.

The following information is important to note 
when importing Assessment questions:

 • Once uploaded, questions can be manipu-
lated like other questions created within the As-
sessment.

 • If there is an error in a question within a fi le, 
only the question with an error will fail to upload. 
Questions without errors will upload successfully.

 • The system does not check for duplicate 
questions. It is up to the Instructor to manage 
this aspect of the Assessment questions.

 • You need to have your formatted ques-
tions ready to go before importing them.

All fi les must be saved as .txt (text) or .rtf (rich-
text) fi le. Do not save as a MS-Word (.doc) or 
WordPerfect (.wpd) document. You may fi nd 
that using excel to create your fi le works well too.

Test Manager
Create a new assessment or survey. Give it a title and enter the description and instruc-
tions in the appropriate boxes. From the Add dropdown box, select upload questions 
and then select GO.

Browse to the fi le containing questions to import. All of the correctly formatted ques-
tions in this fi le will be added to the Assessment.

Creating Assessment Questions for 

Note

Many textbook publishers create test 

banks that are ready for uploading to 

blackboard. This might be an excellent 

resource for you and save you time. 

But please remember to review the 

file for bad questions and other errors.
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Select a point value for each question. When questions are imported they automati-
cally default to the point value set in Creation Settings. If a default value has not been 
chosen in Creation Settings questions will automatically have a point value of ‘0’ and 
Instructors must then enter a point value for each question.

File Structure for Uploading Questions
Questions in the fi le must conform to a specifi c structure to be uploaded to an Assess-
ment successfully. Each fi eld in the fi le is separated by a tab. Each row is a separate 
question.

Multiple Choice Questions are Structured as Fol-
lows:

‘MC’ TAB question text (TAB answer text TAB ‘correct’ or ‘incorrect’)

 • Text within () may be repeated for each of the answers that are part of the Multiple 
Choice question. The maximum number of answers is 20.

Multiple Answer Questions are Structured as 
Follows:

‘MA’ TAB question text (TAB answer text TAB ‘correct’ or ‘incorrect’)

 • Text within () may be repeated for each of the answers that are part of the Multiple 
Answer question. The maximum number of answers is 20.

True/False Questions are Structured as Follows:

‘TF’ TAB question text TAB ‘true’ or ‘false’
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Essay Questions are Structured as Follows:

‘ESS’ TAB question text TAB [example]

Text within [] is optional. The Instructor may choose to add a sample essay question 
or leave this blank.

Ordering Questions are Structured as Follows:

‘ORD’ TAB question text (TAB answer text)

 • Text within () may be repeated for each of the answers that are part of the Ordering 
question. The maximum number of answers is 20.

 • The order entered in the fi le is the correct order. The system will randomly order 
the answers.

Matching Questions are Structured as Follows:

‘MAT’ TAB question text (TAB answer text TAB matching text)

 • Text within () may be repeated for each of the answers that are part of the Match-
ing question. The maximum number of answers is 20.

 • The system will randomly order the answers and their question.

 • When uploading a matching question, there must be a one-to-one relationship be-
tween questions and answers. If not, correct answers may be marked incorrect if 
more than one answer has the same value.
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Fill in the Blank Questions are Structured as Fol-
lows:

‘FIB’ TAB question text (TAB answer text)

Text within () may be repeated for each of the answers that are part of the Fill in the 
Blank question. The maximum number of answers is 20.

Files for Question Pools
The formatting for importing questions into a Question Pool is diff erent from format-
ting for uploading into a test. A special packaging format is required. The easiest way 
to create a fi le is to use an online generator like http://www.csi.edu/blackboard/bbquiz/ 
or software like Respondus (http://www.respondus.com/). As for tests, publishers may 
have packaged pool questions ready for importing.
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A test is a series of questions an instructor presents to students. The purpose of the 
test can be to evaluate concepts, provide drill, or practice exercises. Student answers 
can be submitted for grading, and the results are recorded under each student entry 
in the gradebook.

Step 1: Click on the Test Manager link in Assessment area of Control Panel.

Step 2: Click the Add Test icon. 

Step 3: Type the Name of the Test and a description. When fi nished click submit

Step 4: Type in the instructions. 
When fi nished click submit

Step 5: Choose either random 
block (Step 6A) or From a ques-
tion pool or Assessment (Step 6B) 
and click go

Step 6A: Random Block
 Step A: Choose Test/Pool

 Step B: Choose type of questions

 Step C: Enter number of questions to use 

Creating An Assessment From 
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 Step D: Enter the point per question 

 Step E: Click Import

Step 6B: From a Question Pool or Assessment

 Step A: Choose Test/Pool

 Step B: Choose type of questions

 Step C: Click Search

 Step D: **Check the questions you want to use

 Step E: Click Submit

 Step F: Repeat steps 1 -6 for each pool/test and/or page.

Note: Instructors may select 20 questions at a time from a pool or another assess-
ment to add to a test. If more the 20 questions are found during the search (multiple 
pages), instructors may only select and submit questions from one page at a time.



Blackboard

Lesson #    Topic

Introduction

Objectives

Reading Assignment

Lecture Material or
Course Content

Learning Activity

Self-Assessment

Additional Resources

Reflection/Journaling

Assignment 
(submitted for grading and feedback)

summary of “evidence” on your UBD tree worksheet
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Announcements 
• Pending deadlines, current event notifi cations, FAQ of the week, etc.  

Syllabus (or Course Information) 
1. Syllabus 

2. Welcome letter 

3. Administrative Policies 

4. Academic Integrity Policy 

Staff  Information 
 • Contact information 

 • Response time 

 • Offi  ce hours 

 • Personal bio, if you wish 

Assignments (or Materials) 
 • Module 1 (or Lesson 1) 

 • Brief overview of the lesson

 • Lesson objectives 

 • Reading assignment 

 • Lecture material or course content

 • Learning activity 

 • Self-Assessment 

 • Additional resources/Debrief Statement 

 • Refl ection/Journaling 

 • Assignment (for assessment of module completion) 

 • Exams 

Gradebook (My Grades)
 • Direct link for student access to their gradebook

Books (optional—could be included in Syllabus 
area)
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Discussion Board 
 • Weekly topics 

 • Threads started by instructor 

 • Student questions 

 • Allow new threads 

 • Consider allowing anonymous posts 

 • Archived FAQ 

 • Student Lounge 

 • Allow new threads 

 • Informal, un-moderated area 

Elive!

 • If you have Elive! sessions schedule add a direct link, if applicable

External Links 
 • Web addresses with additional, relevant information 

 • Plug-ins needed in the course

The following two areas come as default links in Blackboard 
and should be reviewed for applicable uses in your class.

Communication 
 • Disable those features you won’t be using  

Tools
 • Disable those features you won’t be using
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CDE is developing a suite of recommendations regarding structure of Blackboard 
classes and materials intended to provide a positive and consistent student experi-
ence. Following are some of the core principles. 

1. Disable/hide sections and tools that are not being used in your class. 

2. Use the Course Information section for “meta” information about the course: 
syllabus, schedule, course policies 

3. Include the Instructor Information section and provide full contact information 

4. Images for Instructor area should be limited to 150 x 150 pixels in the jpg format 
and optimized for web delivery.

5. Course banner may be added to further customize course site. Banners should 
be no larger than 200 x 600 pixels and optimized for web delivery.

6. Course information should include an overall course “map” that lays out learning 
units and due dates (or suggested dates for completion) 

7. Gather learning units and assessments in one section, commonly Course Materi-
als, though this might be customized and named Assignments or Materials, etc. 

8. Course materials should be “chunked” into Learning Modules or Lessons using a 
nested folder structure rather than a fl at listing, and unit folders should be arranged 
chronologically (or reverse) 

9. Individual Learning Units should include as many of the following as applicable/
reasonable (avoid “Read the text, take a test” style units): 

a. Unit Objectives 

b. Reading Assignment 

c. Lecture Material (class notes, etc.)

d. Activity 

e. Refl ection 

f. Self-Assessment 

10. Lecture materials  should include short (1-250 words) materials “in-line” on the 
page rather than all links to external documents (think about students downloading!)  

11. If possible, linked documents should be in a commonly accessible format: HTML, 
PDF, RTF, GIF, JPG, SWF always keeping bandwidth limitations in mind

12. Use of other formats (DOC, DOCX, PPT, MOV, MP3) should be supported with 
clear instructions on obtaining proper viewing software. 

13. Instructors are encouraged to take advantage of publicly provided Learning 
Objects and external links and resources to enrich course materials. 

Blackboard Suggestions
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14. External links and resources should be logically associated with discrete curricu-
lum and/or categorized and given context with a clear direction to get student’s back 
to the blackboard site. Its a good idea to have links show up in a new window (or tab) 
of the browsers.



Blackboard

The Right Format 
The right format for any document will be that which can be read by all of your stu-
dents while still presenting the information accurately. Plain text is perhaps the most 
widely accessible, but you often lose important formatting and layout. Following are 
points discussing the most useful document types for web education. 

HTML/Web Documents 
HTML documents will naturally be accessible to all students. You don’t have to be a 
web developer or know HTML to create HTML documents! Just use the Save As or 
Save for the Web functions in your software. 

PDF Documents 
The Adobe PDF format is a widely used and accessible format. As members of the 
UAF community, you have access to the full Adobe Acrobat program1, which lets you 
create PDF fi les from applications, web pages, or by scanning existing print docu-
ments. PDF documents can be single-page, multi-page2, or even an aggregate of 
various fi les3 already in PDF format. The important points are to try to keep the fi le 
sizes reasonable4 and make sure you provide students with a link to the free Acrobat 
Viewer5 in case they don’t yet have it. 

Offi  ce Documents 
Distributing Microsoft Word, PowerPoint, and Excel fi les can be a useful means of 
exchange as long as your students can view them! Students are not part of the UAF 
site license for Offi  ce. They must understand they will need to own the software, use 
a lab, or install the appropriate viewer6, using links you can provide. 

Standard Graphics Files 
If you use Photoshop, Corel Draw, or other graphics programs to create materials, 
be sure to provide the material in an accessible fi le format. By far, the most acces-
sible will be GIF or JPEG images. If you are targeting other graphics software users, 
TIFF or PNG are the standards. Try to avoid the less standard BMP, WMF, and PICT 
platform-specifi c types. Windows XP, VISTA, and Mac OS X have built-in viewers that 
can handle most fi le types, otherwise there are free webtools that can open almost 
any graphic fi le.

Web Materials That Work
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Multiple Individually Linked Documents 
The most common model used in Blackboard courses is to upload a series of docu-
ments one at a time into the selected course area. While this method is perhaps the 
most straightforward, it is also the least usable for students because it demands a lot 
of navigation from content to index and back, making your material appear discon-
nected. 

Multiple Linked Documents 
A more compact method is to load the fi rst document, then modify that entry and 
continue adding further pages to it.  However, this really only helps cosmetically—
making the index of a folder of documents more compact and making it clear that 
a series of documents are linked together—but does little to improve the student 
experience. 

Linked Module 
An under used feature of Blackboard is the ability to import an entire “module” of 
linked documents at one time. If you are handy with constructing web pages or other 
documents that have their own internal navigation, you can put the whole series into 
a folder, compress them into a ZIP fi le, and then load them in as a single Blackboard 
unit. Blackboard will give you the option to choose which document the students 
should start with. This is a particularly useful feature if you are using similar materi-
als in another context, and it greatly improves the student experience by making the 
material more cohesive. However, you will have to create some kind of navigation 
within your documents themselves, which can be time consuming. 

Blackboard Learning Unit 
Blackboard has its own facility for creating a sequential series of instruction called 
a Learning Unit. By creating a learning unit and then adding a series of documents, 
links, and fi les, you can create a structured curriculum path without having to create 
the internal navigation yourself. In this model, you can control whether the student 
must access the material sequentially (as we have in the sample) or if they can jump 
around using the Contents button available in the learning unit.

Presenting Sequential 
Materials in Blackboard
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The Blackboard Learning system can be a valuable addition to any class, but to be 
eff ective students must know how to use it! Take some of the drudgery out of the 
process by allowing students to discover by doing—in this case by utilizing a simple, 
but eff ective, Blackboard Scavenger Hunt. 

Learning Objectives 
Students familiarize themselves with the following primary Blackboard tools/areas: 

 • Announcements 

 • Course Information area  and Course Documents (content) area 

 • Discussion Boards 

 • Assessments 

Students demonstrate their mastery by completing a brief Blackboard assessment. 

Format/Process 
1. Place “items” in appropriate locations in your Blackboard course in various for-
mats (items should be similar format to regular class materials) for example: 

 • in a Blackboard Announcement 

 • in a document in the Course Information area 

 • in a folder within the course documents section 

 • in the class syllabus 

 • in a discussion board posting 

 • in a document passed to the student using the Digital Drop Box 

2. Create a short, point-bearing Blackboard quiz asking for the items they found

3. Create a handout (paper, Word, or PDFext) outlining the Scavenger Hunt items, 
tips on locations, and a place to note answers. Don’t forget to indicate where they go 
in your course to take the quiz. Provide the handout to students as early as possible, 
preferably before asking students to use Blackboard to access course curriculum. 

4. Finally, students will complete the quiz using the items they have found. 

More Resources 
For more information on using scavenger hunts on Blackboard refer to this article:
http://jolt.merlot.org/Vol2_No2_Jones.htm.

A Blackboard Scavenger Hunt



Blackboard

Getting Help
Blackboard Support

UAF: http://www.alaska.edu/oit/training/blackboard/index.xml

http://www.alaska.edu/oit/training/Documentation.xml#blackboard

helpdesk@alaska.edu or call 907-450-8300 or Toll Free (800) 478-8226

CDE Student Tutorials
http://distance.uaf.edu/archives/students/substudents/getting-help-1.php

External Resources
Blackboard Support Center
https://behind.blackboard.com/s/faculty/

Blackboard and Course Cartridges
http://cartridgecatalog.blackboard.com

Blackboard Faculty Users Listser
http://www6.miami.edu/bb/bbfs/

BYU-Idaho Blackboard Test Generator (Tests)
http://www.byui.edu/onlinelearning/employees/testgen/index.htm

College of Southern Idaho Blackboard Quiz Generator (Pools)
http://www.csi.edu/blackboard/bbquiz/ 

Getting Started with Blackboard and other Quick Guides
http://www.itd.depaul.edu/website/documentation

Blackboard Resources
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Quality Matters
In 2003, a consortium of Maryland colleges and universities (MarylandOnline) re-
ceived a FIPSE grant to study the features that indicate quality in an online course. 
They initiated a peer-evaluation process, and ultimately developed a set of criteria 
based in research literature. They adopted the name “Quality Matters” for their proj-
ect and the resulting documentation.

The three-year grant ended in Fall 2006. The Quality Matters program continued and 
expanded beyond the scope of the original grant. Quality Matters now off ers insti-
tutional subscriptions as well as a variety of fee-based services. The institutional sub-
scription allows partnering universities and colleges to become part of their network, 
attend training opportunities, and participate in the peer review of courses.

The original materials authored under grant funding are in public domain. They may 
be accessed from the Quality Matters web site: 

http://www.qualitymatters.org/FIPSE.htm

With their permission, we’ve included a copy of the Research Matrix here in your 
binder. This document provides an excellent research base for many of the course 
design elements we recommend in our checklist.

Course Design Rubric
Our own, internal rubric was developed as a team eff ort among local instructional 
designers and consultants. It is available on the CDE web site:

http://distance.uaf.edu/archives/research/subresearch/course-quality.php

Course Development Checklist 
More recently, we developed a checklist of course design elements. We use this 
checklist as a communication tool between instructional designers and course devel-
opers. In the creation of this tool, we reviewed similar documents from other post-
secondary institutions. We borrowed ideas from many places, but most heavily from 
St. Petersburg College in Florida: http://www.spjc.edu/

A copy of the CDE Course Development Checklist is included in the following pages. 

Online Course Quality
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“For this assignment you need to read Joseph Marshall’s The Journey of Crazy Horse: 
A Lokota History and watch the 1993 fi lm Geronimo directed by Walter Hill. Write a 
three to four page essay (typed and double-spaced) that compares and contrasts the 
main themes presented in both. What questions or issues do the author and direc-
tor raise in their works? What purposes do you think they had for either writing the 
book or making the fi lm respectively? Are these purposes achieved? Are there fl aws 
or weaknesses in either of these works? Finally, can fi lm serve as an eff ective medium 
for historical discourse?”

[Writing an essay is an assignment which can be assessed, but watching the video 
and reading the book are activities... which demonstrates the integration of activities 
and assessments]

Comparative Essay
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Peer Critique

In this course, 30% of the course grade is based on student participation in an online 
photo sharing site (Flickr). Students are required to take a minimum of 25–50 photos 
per week. Of those photos, they select an average of fi fteen to post on Flickr. Of the 
fi fteen, they select 2-3 of their BEST shots for the week and add them to the class 
pool on Flickr. This consolidates the class’ self-determined best work into one loca-
tion and makes it convenient for class members to view the work of their peers.

As an integral part of the Flickr participation grade, students post constructive com-
ments for their classmates. This method of public participation and peer review ac-
complishes several purposes:

 • It requires the student to self-assess and select their own best work

 • It raises the bar for performance quality by displaying student work to a 
larger audience (beyond the classroom)

 • It gives opportunity for students to draw inspiration from classmates’ photos

 • Flickr displays camera settings (shutter speed, aperature, ISO), which helps 
answer the question “how did they do that?”

 • It requires students to think critically about the work of others, and to articu-
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late what they like or dislike about the work

 • It increases the quantity of feedback the student receives. Students receive 
feedback from other students and from the general public, as well as from the 
instructor. 

Refl ection Activities
A variety of publisher created activities are made available for students to use as 
study aids. In this activity the student gets to choose between these activities or try 
them all. A written refl ective response is submitted to the instructor. The instructor is 
looking to see how the student used the activity and if the student felt it was helpful.

Examples of student responses:

“I completed the crossword and the fl ashcards, both of which I felt helped me. I 
cheated a little bit on the crossword but it was still fun learning which I really enjoy. 
The fl ash cards were straight up and they helped me because I have a hard time with 
memory. I really enjoyed both of those activities and will probably go back and do the 
other just for the fun of it. Thank you.”

“Hello, I completed the crossword puzzle.  It was diffi  cult but fun at the same time.  
This method of learning is great.  Doing this crossword was challenging in the defi ni-
tions of the text, but I picked up more than if I had just read the defi nitions and 
answered questions about them.  I enjoy doing diff erent assignments like these, they 
make the information stick in your brain a little better.”

“As an audio learner, the Flash Cards are my favorite tool of the three on this section.  
One has the benefi t on downloading the MP3 for continuing study away from this PC.  
This is great as I’m still chewing on the material.”
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Sample Refl ection Questions for other types of Refl ection

 • After completing this lesson, what questions do you have or want to investi-
gate further?

 • Are you experiencing any challenges with key course activities: (discussion 
board, group work, etc.)

 • How diffi  cult did you fi nd this lesson material in relation to the other lessons?

 • Which concept caused the most diffi  culty for you in this lesson?

 • Which concept did you fi nd the easiest? 

 • Which topic did you fi nd the most interesting?

 • Which topic do you think applies the most to your life? (Which are you most 
likely to use?)

 • It would be helpful to me if there were more example problems about:

 • Please let me know if you feel you are “on track” for fi nishing the course on 
schedule. If you would like reminders, example problems, or additional assis-
tance, this is your chance to ask for guidance. Let me know how I can help you 
succeed in the course!

 • Write a one-sentence summary of this week’s most important topic.

 • What was this lesson’s “muddiest moment” for you?

 • Describe an experience you have had relating to (the topic of the lesson)

 • Explain how (the topic of the lesson) will play a part in your life ten years 
from now.

 • What is interfering with your learning right now?

 • How will you use the information you’ve learned from this lesson?

 • Based on the concepts developed in this lesson, describe one real-world ap-
plication for this theory (process, principle, or whatever it is etc.)

References

About.com: http://712educators.about.com/cs/writingresources/l/bljrnlacademic.htm

The Online Learning Idea Book, Shank, Patti, Editor, 2007, John Wiley, & Sons, Inc. 
Pfeiff er, Adapted Classroom Assessment Techniques, pages 31-32, submitted by 
Joanna C. Dunlap, assistant professor, School of Education and Human Development, 
University of Colorado at Denver and Health Sciences, Denver Colorado, USA; page 
178-179, submitted by Terry Morris, associate professor, William Rainey Harper Col-
lege, Palatine Illinois, USA.
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Concept Quilt

Student is given a variety of articles to read for the assignment. This worksheet asks 
students to summarize the core concepts and to describe the common thread or 
understanding between the readings.
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Visual Digital Quilt (a variation)

A visual digital quilt is used as an introduction activity to get students thinking about 
themselves and how they would want to introduce themselves to the class. This is ac-
companied by a written introduction and explanation of why the images were chosen.
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A fi nal activity gives the students an opportunity to provide a visual picture of what 
they have explored, experiences, and learned throughout the course. This is also ac-
companied by a written refl ection piece.

Images are submitted and shared with the other students.
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What’s In Your Closet?

 “For this assignment you will make connections between the readings for this 
course, and the Making Connections Map 4 you created with the clothing tags from 
your closet. In this paper, refl ect on the politics of food and clothing, their produc-
tion, distribution, and consumption around the world, and ho the themes we’ve 
explored in this course: the interactions of science and culture, national and inter-
national politics and economics, marketing and advertizing, travel and migration, 
the interaction of race, class, and gender impact the clothing in your closet. Refer to 
readings from the course to demonstrate the connections you are making from the 
global to the local to the personal of what is in your closet and what you wear on 
your body. Save the completed fi le as ClosetMapPaperYourName and use the assign-
ment submission procedures to submit this assignment for grading before 11:59 pm 
Alaska Time on due date.

There is no “page number” requirement or limit on this assignment. Use as many or 
as few pages as you need (one will do if you can make these refl ections in one page, 
or more if you need more).”

[Courtesy of Kayt Sunwood] 
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Visualization

 Tools are emerging which make it easy for teachers and students to visualize diff er-
ent kinds of information without the need for complex technical skills. ManyEyes 
(http://manyeyes.alphaworks.ibm.com/manyeyes/) is shown above, visualizing data 
that was simply cut and pasted from a spreadsheet.

Visualizations aren’t limited to numeric data either! Word clouds, such as the follow-
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ing are easy with tools like Wordle (http://wordle.net/):  

Wiki Collaboration
A wiki provides a place for simple collaboration between students… you can think of 
it as a shared notebook where students collaboratively create and revise stories, ar-
ticles, defi nitions, etc. Because wikis are available asynchronously and handle multiple 
edits (including retaining a history of changes and reversion ability) they are more 
effi  cient than circulating shared documents. And because students are collaborating 
directly on the same source fi le, the wiki is more productive than exchanging informa-
tion via a discussion forum or email… particularly when more than two students are 
involved.
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Student Blogging

Blogs allow students to publish and engage in a sphere beyond the classroom. Stu-
dent or class blogs are sometimes presented as an alternative to discussion boards… 
and while this is sometimes functionally true, they have very diff erent dynamic. Un-
like discussion boards, blogs provide foundational features for learning community 
because they are:

 • Widely available

 • Mature

 • Relatively interoperable

 • Available personally, externally, and institutionally 

Blogs provide the tools necessary for the basic community activities that will be 
undertaken by the learner, including:  Presentation, Commentary, Conversation, Col-
lection, Collaboration, and History and Artifacts



Learning Activities

Making Connections Map
“This Making Connections Map is diff erent than the previous maps, as this time you 
don’t just fi ll in the blanks to identify countries from the readings. This time you will 
map what’s in your closet (or wherever you keep your clothes) by examining the tags 
on your clothing that indicate where each item is made. You will pick 8 items from 
your closet (each one must come from a diff erent country - thus you will have 8 diff er-
ent countries identifi ed on your world map). If you don’t have clothing with tags from 
8 diff erent countries you can use the clothing of family, or friends, or housemates, or 
co-workers, anyone who will let you look at the tags on their clothing. What you will 
do is place sticky note icons on the map over each of the countries where each item 
was made, then in the sticky note text box, you will put the name of the item, and the 
country where that item is made (which, of course, should be the country under the 
appropriate sticky note icon!).”

[Courtesy of Kayt Sunwood]
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Asynchronous Presentation

http://voicethread.com

Voicethread is a media photo album that can use all types of media: images, videos, 
audio (microphone or phone) text, annotation. Plus it allows for group interaction on 
an asynchronous basis

VoiceThread

Commentngs tools include:

 • calling in by phone

 • adding video

 • recording audio

 • typing a comment

 • drawing with a pen tool (in diff erent colors)

and somtimes doing more than one at the same time!
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Spanish Grammar Class
goal: evaluate student oral performance

 • Series of slides for a student to work 
through the semester

 • Instructor gives her instructions in 
Spanish

 • Student answers her questions (using 
perfect Spanish grammar)

Instructor speaking

 

Student speaking:
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Math Example:
http://voicethread.com/#q+math.b8149.
i60081

goal: have student explain how to solve 
problem

 • instructor provides equation

 • student talks through the process 
as they write on the board

 • students and teacher can evaluate 
or comment

Other VoiceThread Examples:
 • http://voicethread.com/?#u4289.b3352.i28616- visual art history class – able 

to identify and describe 
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 • http://voicethread.com/#q+art.b81021.i420528 - sign language class with 
video

 • http://voicethread.com/#q.b48359.i253692 - visual interpretation, story tell-
ing
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 • http://www.slideshare.net/suziea/voicethread-examples-in-education-pre-
sentation

 • http://voicethread.com/#u449599.b21651.i122786 - video doodling feature

What others are saying:
Discussion Board Alternative, Visual and Oral Assessments, Instructor Presentation, 
Student Presentations, Tutorials, Assignment/Syllabus Overview, Digital Portfolios, 
audio Feedback for individual Students, lab reports, math process

Account Information:
Free: - unlimited commenting, 3 voicethreads, 75 MG free storage space

 • Single user unlimited number of voicethreads, 10 G storage space, phone 
commenting, archival movie exports, create and manage groups

 • Higher Ed Manager create accounts for students and colleagues

Resources:
http://www.education-world.com/a_tech/columnists/dyck/dyck023.shtml

http://voicethread4education.wikispaces.com/College

http://www.slideshare.net/brocansky/voicethreads-interactive-visual-and-collabora-
tive-learning-spaces

http://thinkingmachine.pbwiki.com/Think-VoiceThreads

http://www.edutopia.org/voicethread-interactive-multimedia-albums
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Discussion Board Rubric Example
http://www.udel.edu/janet/MARC2006/rubric.html
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Discussion Board Rubric Example
http://www.txdla.org/Conference/2008/program/presenterresources/299_Discussion-
BoardRubrics.pdf
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Video: 
YouTube and other Video/Film Resources
Created for education, the edu site was created specifi cally for college and unversi-
ties to act as a fi lter. 

 • http://www.youtube.com and http://www.youtube.com/edu

“The best free cultual and Education media on the web.” This site hosts links to 
audio, podcast, and video presentations. One link called Intelligent YouTube has gath-
ered 80 “smart” video collections.

 • http://www.openculture.com/

A 

YouTube Channel of videos presentations of “thinkers”

 • http://www.youtube.com/bigthink

A collection of places to fi nd documentary fi lms

 • http://www.makeuseof.com/tag/the-best-places-to-watch-documentary-
movies-online/

The periodic table of video - all the elements explained.

 • http://www.periodicvideos.com/

 • A site created specifcally for instructional 
videos
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 • http://www.teachertube.com/

Merlot: Multimedia Educational Resource for Learing and Online Teaching. A collec-
tion of peer reviewed higher education, online learning materials. Collection contains 
video, audio, reuseable learning objections

http://www.merlot.org/merlot/index.htm

Audio: Podcasting and other Audio Resources
Collections of recordings:

 • http://odeo.com/

 • http://epnweb.org/index.php

Foreign Language (including english as a second language and 
business english)

 • http://www.openculture.com/2006/10/foreign_lan-
guag.html

iTunes University - specifi cally for college and universities:

 • iTunesU
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Powerpoint
How to avoid a bad Powerpoint presentation.

 • http://www.youtube.com/watch?v=cagxPlVqrtM 

Adding Audio Narration to a Powerpoint

 • http://www.slideshare.net/delhionlineeducation/adding-audio-narration-to-
powerpoint

Slideware: a place to store and share your presentations:

 • http://www.slideshare.net

Suggestions on Creating Powerpoint for Elive
1. Compress all images before putting them in the presentation itself.

2. Use a simple slide template with few colors

3. Use legible fonts with large enough font size

The ELIVE Presentation Wizards is also a helpful resource to be familiar with:
 http://www.elluminate.com/support/tools/presentation_wizard.jsp



Asynchronous Presentation



Elluminate Live



Elive



Elive

Abstract
Elluminate is a virtual, synchronous learning environment made specifi cally for dis-
tance education and collaboration in academia. Use Elluminate to add live discussion 
and dynamic interaction to your asynchronous distance learning. Elluminate lets you 
extend the physical boundaries of your traditional classroom. The result—engaged 
students, enhanced learning, and improved comprehension.

 • Abstract 

 • Minimum System Requirements

 • Introduction

 • In-Session Management

 • Communications

 • Presentation and Collaboration

 • Advanced Content

 • Features of Elluminate

 • The Toolbar

 • Polling

 • Polling: Best Practices

 • Breakout Rooms

 • Breakout Rooms: Best Practices

 • Direct Messaging

 • Direct Messaging: Best Practices

 • Audio

 • Audio: Best Practices

 • The Whiteboard

 • Whiteboard: Best Practices

 • File Transfer

 • User Profi les

 • Application Sharing

 • Application Sharing: Best Practices

 • Web Tours

 • Web Tour: Best Practices

 • Elluminate Best Practices

 • Some other suggestions for making 
the best use of an Elluminate session:

 • Getting Help

WHAT YOU”LL FIND IN THIS SECTION:
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Minimum System Requirements
A computer must have the following minimum system requirements in order to use 
Elluminate Live:

All computers require:

 • Java versions 1.5 or 1.6

 • 20 MB free disk space

 • Soundcard with speakers and microphone or headset (or telephone for 
Telephony users)

 • 28.8 Kbps Internet connection

Windows:

 • Windows 2000/XP/Vista

 • Pentium III 1 GHz processor

 • 256 MB RAM

Macintosh Client:

 • Mac OS X 10.4 and 10.5

 • G4, G5 of Intel processor

 • 256 MB RAM

Solaris Client:

 • Solaris 10

 • UltraSPARC 500 MHz

 • 256 MB RAM

Linux Client:

 • Red Hat Linux (RHEL4), Novell SUSE 10

 • Pentium III 1 GHz processor

 • 256 MB RAM
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Introduction
Both students and instructors can access Elluminate from anywhere in the world, 
using any platform, and any bandwidth (as low as 28.8). Even users with vision or 
hearing disabilities can participate fully in Elluminate sessions.

Elluminate allows for essential social networking. A strong online social network 
allows for a community of geographically distributed users to enhance collective 
knowledge which is a driving force for eff ective learning. Elluminate reinforces social 
networking through interactive recordings, user profi les, and other features. 

There are two key components to Elluminate: an easy to learn and use interface and 
universal access. 

The interface is easy to use and learn allowing users to quickly forget about the tech-
nology and fully participate in the session. All users are in sync at all times because 
the Elluminate data stream is specifi cally designed to adapt to the connection speed 
of each individual user. 

Universal access means any user on any platform (Windows, Mac, and Linux), using 
almost any bandwidth can participate in an Elluminate session. Moreover, Elluminate 
supports the Americans with Disabilities Act (ADA) and is compliant with section 508 
of the rehabilitation act. Accessibility features include multiple streams of closed 
captioning, enlarged video windows, and auditory event notifi cations.

In-Session Management
A moderator (often an instructor) is the person hosting or controlling an Elluminate 
session, while a participant (usually a student) has little to no control, although they 
can still interact in the environment fully. During an Elluminate session the modera-
tor has granular control over the environment, meaning they can see and infl uence 
everything that’s going on.

Looking at the screenshot provided 
you can see who is logged in as moder-
ator (bolded) and who is logged in as 
participants (not bolded). You can also 
see the permissions each participant 
has. Permissions are shown by the 
icons next to each person’s name. As a 
moderator you can add and take away 
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a participant’s abilities to use the whiteboard, audio, direct messaging, or application 
sharing just by clicking the associated icon next to a person’s name. 

You’ll notice also there is a raised hand column next to each person’s name that 
shows when a participant has raised their hand, which will allow you to ask them 
questions in real time. When a hand is raised the area below their names will fl ash. If 
multiple participants raise their hands simultaneously the moderator will be able to 
see in what order they raised their hands by the associated and sequential number 
that will appear in the hand-raised column next to the participant’s names. 

“Extra Sensory Perception”
The Internet is an unpredictable medium so Elluminate wants to make this as little 
of a nuisance as possible. Built into Elluminate is a feature called Moderator ESP that 
detects if users are experiencing any kind of internet delays, adjusts their presenta-
tion accordingly, and tells the moderator if anyone has fallen behind.

A yellow indicator light tells the mod-
erator a student is about 3-5 seconds 
behind. While a red indicator says a 
student is 5-8 seconds behind. The 
second the indicator light goes off  the 
moderator knows the student can see 
everything on the screen.

The audio stream is also constantly 
being buff ered while it is coming in. 
So for example if you have an internet 
delay of 10 seconds you wont hear 
anyone speaking during that time 

but when the sound comes back it will speed up and be just a little bit higher pitched 
for about 10-20 seconds because you are catching every single syllable of what was 
missed while you had your outage so nothing is missed!

Communications
Elluminate gives you 5 communication channels: audio, direct messaging, live video, 
closed captioning, and user profi les. 

2-way audio is always full duplex, crystal clear, and allows up to 4 people to communi-
cate at once. 
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Direct messaging allows private and public text messaging. Moderators can choose 
to see all private or public conversations. Emoticons – such as laughter, confusion, or 
disapproval - can also be used in the direct messaging window. 

Live Video can be used by one user at a time. You can select image quality from a 
coarse gray to a fi ne color. Therefore students with diff erent degrees of bandwidth 
don’t have to sacrifi ce their overall experience. You can also increase video size for 
those with disabilities or for presenting in a classroom. Many types of video are sup-
ported including DirectX, compressed video, Fire wire, camcorders, and web cameras.

There is a utility to allow all audio content to be closed captioning for the hearing 
impaired. You can have students captioning in English and other languages as well. 

User profi les allow users to create profi les including their name, address, email, 
phone number, picture, and so forth. You can then email students directly from a live 
session or from the recording. 

Presentation and Collaboration
The dynamic, object-oriented whiteboard allows you to draw lots of objects such as 
circles and rectangles. You can also color and move these objects around. You can 
give students the permission to use the whiteboard allowing them to move objects 
around as well. 

ou can use application sharing to share any application on your desktop. You can also 
request desktop control of another user’s computer. 

Breakout Rooms allow you to have separate, simultaneous sessions allowing you to 
break larger groups into smaller groups. You can have as many rooms or as many 
people in each room as you want. The moderator can go into any room at any time and 
can always respond to any questions anyone has no matter what room they are in.

You can also use polling to get answers to yes/no questions, multiple choice ques-
tions, or any other type of question you might want to ask your audience. You can 
even customize quizzes if you have more complex needs.

Advanced Content
You can use the File Transfer feature to give fi les to students, and they can share fi les 
with you in return. Any fi les you upload this way transfer during the recording as well, 
if you make one. File transfer is a great asset for students who missed the class or 
lost the fi le.
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Web tours allow you to open the student’s web browser and take them to a website. 
Once there you could have them interact with the site in some way such as by having 
them fi ll out a survey or form. Or you could just take them to a website so they could 
see what’s available.

Multimedia fi les can be loaded into Elluminate Live – although this is discouraged for 
bandwidth considerations.

There is a graphing calculator you can share with students or have them use on their own.

Finally, you can record all interactions - except private messaging - that occur during 
a session. Users who missed the session or who want to review the material can go 
back and watch the presentation at their convenience.  

Features of Elluminate
The Toolbar

Use the toolbar to do any of the following:

 • Change the windows layout.

 • Access polling in class (Yes/No, Multiple Choice with three, four or fi ve 
answers, Class Pace “Slow Down/Speed up” and whether to show or hide the 
polling responses).

 • Access Application Sharing, where the moderator or any student will be able 
to share any application, a specifi c region of their desktop, or their entire desktop 
with others.

 • Transfer fi les by loading a fi le or URL, to view the list of shared fi les, or to 
save and delete the shared fi les.

 • Broadcast Video in your session.

 • Activate the timer for timed assignments.

 • Print what you see on screen.

 • Take personal notes about the session.
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Polling

Tools > Polling > [select type]

Polling is used to get quick answers for either verbal or written questions. By default, 
when you fi rst join a session, the polling tool is set to capture yes or no answers from 
students. However, you can change it to accept multiple choice answers.

Polling results can be viewed by the moderator and students. Be default however 
only the moderator may see the poll results. To see poll results, select the following:

Tools -> Polling -> Show Statistics

Polling: Best Practices

 • Since it is helpful to get real-time feedback while you are lecturing it is some-
times useful to put the polling setting on class pace so that audience members 
will have the option of telling you to speed up or slow down at any time.

 • Consider making the fi rst few slides of a presentation questions that audi-
ence members can respond to with polling. You can use these questions to test 
student’s understanding of the previous session’s material or of the reading. This 
is a great way to test student progress!

 • You should use polling occasionally during a presentation as a way to wake 
up the audience or just for interactive “fun”, especially when you suspect audi-
ence members are getting sleep or restless based on a long presentation. If you 
didn’t prepare questions in advance you can always give students a 5-10 minute 
break while you think of questions to engage them with.

Breakout Rooms

Tools > Breakout Rooms > Create Breakout Room…

Breakout rooms can be used for collaboration and group activities or even for indi-
vidual work assignments. If collaborative, breakout rooms can be used for students 
to introduce each other, work on homework problems or projects, conduct research 
or brainstorming assignments, or work on other small group activities. When done 
you can have the groups present their work to the rest of the audience.

Breakout rooms can also be used for individual student assignments. For example, if 
you wanted students to work on a drawing or visualization exercise individual break-
out rooms would be a great way to do this. You could then bring the students back 
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into the main room when done and have them share their work, or merely save the 
slides for your own viewing later on.

The moderator determines how many groups to create, which students are put in 
specifi c groups, and all activities related to that room. Breakout rooms are similar to 
real physical rooms. Students in one breakout room have access to all the features of 
Elluminate but do not hear, nor know what is happening outside the room. A mod-
erator outside the room has to go in the room in order to assist students; although 
students in breakout rooms can still private message the moderator or raise their 
hand for help.

Breakout Rooms: Best Practices

 • Use the timer to let students know when individual or group assignments 
are to be completed.

 • Use breakout rooms to have students prepare for upcoming events or com-
petitions collaboratively.

Discussions among students in the breakout rooms will motivate them toward fur-
ther learning in the subject and develop their problem solving or thinking skills. It will 
also give them time to construct their own meanings.

Direct Messaging

Direct Messaging is a text-
based communication tool 
that provides real time deliv-
ery. Messages can be public 
or private and are color-coded 
according to the following 
criteria:

 • Black messages are public (sent to everyone in the session)

 • Blue messages are private (a privately sent or received message)

 • Red messages are private (a student sends a private message to another 
student)

Direct Messages can be saved and printed, resized, fi ltered (moderator may wish to 
view only certain messages), and tracked when messages were sent by clicking on 
the Display date and time icon. Even if a student has no permissions to use the direct 
messaging tool, they can still send a private message to the moderator(s).
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Direct Messaging: Best Practices

1. The Direct Messaging window is:

a. A safe area for students, where they can feel at ease and write freely, especially 
when they feel intimidated by the new technology or the other people in the class

b. The most important area for the moderator to be consistently aware of 
throughout a session. Through practice, a moderator will learn to keep an eye on 
the Direct Messaging window in order to keep track of the responses, questions, 
inquiries, interactions, and reactions of the students at all times while still using 
the other features of Elluminate eff ectively

2. Direct Messages may be used for introductions or brainstorming activities

3. Group work can be eff ectively accomplished with direct messaging in order to 
help foster a community, social interactions, or collaboration. Similar to breakout 
rooms, direct messaging can be used for collaboration and group activities in in-
troductions, brainstorming, open-ended questions, and other activities. In order to 
achieve this purpose, group students by pairs or small groups and tell them to chat 
privately. The moderator may view small group conversations by using the Direct 
Messaging fi lter. Then all students can share their fi ndings and discussions with the 
rest of the class.

Audio

Take a look at the screenshot to the right. This is a 
screenshot taken from an actual Elluminate class in 
session. There are a few important things to notice here 
including the yellow halo around the microphone icon 
next to the moderator’s name and the grayed-out Talk 
button (at the bottom).

You can see a yellow halo behind the microphone 
permission indicator in the student window, next to the 
moderator’s name (nfzgn), which means that the mod-
erator is currently talking. 

In the audio window, a student can click on the TALK 
button, and is then able to participate in conversations 
during the session. Elluminate is now full-duplex and up 
to four people can talk simultaneously. To use the audio 
feature, your computer must have a sound card, micro-
phone and speakers. Headsets are strongly recommend-
ed for all participants.
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Before your FIRST Elluminate Session: use the ‘Audio Set up Wizard’ to confi gure 
your Audio. 

Tools > Audio > Audio Setup Wizard…

Alternatively, you or your students can use a preconfi gured Elluminate room 
to set up audio: https://sas.elluminate.com/site/external/jwsdetect/meeting.
jnlp?sid=345&password=M.AD379BCB0A40D3D8C33C6B16A84C0B&username=Test. 
This room is always available.

During a session you may use the audio window panel in the following ways:

 • Click on the TALK button or use the hotkeys (Ctrl+F2) in order to enable or disable 
the talk feature.

 • Adjust your microphone and speaker levels manually.

 • Audio: Best Practices

 • At the beginning of each session it is often helpful to have each student 
introduce themselves. It is a test for their audio set up and also helps creates 
community. 

 • While using other features of Elluminate, like Application Sharing or the Web 
Tour, you can still control the Audio feature by using the hot keys: Ctrl+F2 to en-
able or disable the talk feature. 

The Whiteboard

The whiteboard is where any content 
will appear. In the example here you see 
that the phrase “Good morning” has 
been written in diff erent languages on 
the whiteboard. In some cases the text 
was typed in using the text tool, and in 
other cases it was written in free hand 
using the pen tool (in various colors). 
Clip Art (the coff ee mug and the smiley 
face) have been inserted using the 
Screen Capture tool in the Whiteboard Toolbar. 

You can insert various images and slides, including PowerPoint slides, as well as type, 
write using the pen tool, highlight, or even draw simple shapes such as circles and 
rectangles on the whiteboard.
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The whiteboard is the main presentation window in Elluminate. It is used either as 
a presentation tool or as a work area where students can write, draw, type, import 
fi les, images, or clip art. The moderator manages and controls the screens, the 
screen content and the student’s access to these screens. 

The Whiteboard off ers great opportunity for interactions, especially in small groups. 
So be creative, courageous, and spontaneous! Open new blank screens and impro-
vise! Do not be afraid to try new ideas when using the whiteboard collaboratively 
with your students. 

Whiteboard: Best Practices

 • Use it as you would a regular whiteboard, chalk board, or fl ip chart in a face-to-face 
class. Write, draw, or type on the board, and encourage students to do so as well. 
Try solving problems together, discussing solutions, brainstorming, visualizing, col-
lecting responses, and sharing ideas. Remember that all objects on the whiteboard 
can be edited!

 • Use a tablet pc to make writing and drawing on the whiteboard even easier (espe-
cially useful for math or science courses where formula are commonplace).

 • Allow multiple people to write or type on the whiteboard simultaneously by ma-
nipulating your student’s permissions.

 • Take screen captures of images or applications on your computer and paste them 
to the whiteboard for all students to see or draw on.

 • Use games and simulations on the whiteboard as part of your ‘Active Learn-
ing’ strategy. 

 • As a presentation tool, ideas can be recorded and student interactions can 
be saved. The PowerPoint presentation is static, so try to think of some creative 
ways to change that. For example: 

 • Highlight content on PowerPoint slides.

 • Annotate your presentation.

 • Create a ‘white box’ to cover some of the material and move it around as 
you proceed through the content to make the presentations more dynamic and 
focused on the parts you are actually talking about at any given moment and to 
create suspense for other points still to come.

 • Customize your clip art and share it with your students.

 • Use the ‘Explore Screens’ tool (Tools  -> Whiteboard ->Explore Screens) to 
control your whiteboard screens.

 • Save and print your whiteboard screens for later use.

 • Use the ‘Explore Objects’ tool to see which students have contributed to 
each screen (Tools - Whiteboard - Explore Objects).
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 • Take a screen capture of the entire Elluminate interface for your fi rst session 
to show students how Elluminate works.

 • Share polling results with students by pasting them to the whiteboard.

File Transfer

Use the ‘File Transfer’ tool to share fi les with students in an Elluminate session. These 
fi les will also be transferable in a recorded Elluminate session.

User Profi les

Set up your own user profi le including name, title, e-mail address, address, phone 
number, and picture and encourage students to do the same. By rolling their mouse 
cursors over each other’s names in the Participant’s Info box in Elluminate students 
(and you) can see each others profi les.

Application Sharing

Tools, Application Sharing, Host Applications…

Application Sharing allows participants to share any application, a specifi c region of 
their desktop, or their entire desktop with others in the conference. A participant can 
even give control of their shared application or desktop to another participant!

Application Sharing is great for showing students how to use software applications 
such as Microsoft Word or Excel. It is also useful for taking control of a student’s 
desktop in order to troubleshoot problems with their operating system. There are a 
few drawbacks to using Application Sharing however, the main drawback being that 
it requires higher bandwidth than most Elluminate features. So be careful about using 
Application Sharing extensively when your students have slower connection speeds 
than yourself.

Application Sharing: Best Practices

1. Share the Elluminate application itself in order to show students how to use it 
(requires a second instance of Elluminate).

2. Share your web browser with Blackboard loaded in order to go over the course syl-
labus, or other features of Blackboard you want your students to be comfortable with.
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3. Share your web browser when logged into sites that require a username and 
password. This is the only way you can share password-protected web sites with 
your students.

Web Tours

Tools, Web Tour, Start Web Tour…

The web tour tool allows you to take students to a website or series of websites 
using an embedded browser. When you start a web tour each participant’s default 
browser will load on their computer and go to the site you have directed them to au-
tomatically. Once they are there they can surf the web independently, but will always 
be brought back to the page you want them to see when the page you are looking at 
in your browser changes state.

Web Tour: Best Practices

Use the web tour tool to take students to a website that has some sort of content 
you want them to see or become familiar with (such as an art gallery, some prose or 
poetry, or an animation of some kind). Give them some time to become familiar with 
the content, and then have them work in small groups on an assignment based on 
that content, or just have them share their impressions with the group.

Elluminate Best Practices
It’s always a good idea to prepare materials for a class and Elluminate is no diff er-
ent. If anything it’s even more important to prepare materials before an Elluminate 
session. The best way to accomplish this is to load all your presentation fi les (Power-
Point slides, images, text, and other materials) into Elluminate, organize your slides, 
and then save your Elluminate presentation as a whiteboard fi le. 

File -> Save -> Whiteboard…

Here are some other suggestions for making the best use of an Elluminate session:

 • Do an initial poll with students to see what they want out of the session.

 • When using breakout rooms make sure you let students know what is 
happening before putting them in the room or they made get confused by the 
immediate absence of audio; also be sure to tell them what to do in those rooms 
before sending them there.



Elive

 • Build quizzes ahead of time using the quiz manager.

 • Don’t use images that are too big for the whiteboard.

 • Don’t talk too long without interruption or your students will lose interest.

 • Use text chat fi lters.

 • Prioritize communication channels

 • Disable student use of tools at the beginning of the session and only enable 
 them when necessary.

 • Create PowerPoint slides that invite interaction.

 • Make students take the fl oor occasionally to get them involved.

 • Make one student a moderator in each breakout room.

 • Don’t talk alone in a room!

Getting Help
How to get the Java plug-in and Java Web Start on your Computer: 

This software is needed to run Elluminate on your computer.
http://www.elluminate.com/support/softwaredownload.jsp

PDF/PowerPoint/Open Offi  ce/Star Offi  ce Converter: 
Converts fi les from all of the aforementioned programs into Elluminate whiteboard slides.
http://www.elluminate.com/support/tools/presentation_wizard.jsp

Get a FREE vRoom: 
Elluminate is now off ering free rooms where you can try out Elluminate Live. You just 
need to fi ll out a short form on the following page.
http://www.elluminate.com/vroom/register.go

Elluminate Support
Includes a confi guration room for getting yourself and your audience confi gured for 
a scheduled session beforehand (includes audio setup for speakers and microphone). 
Also includes a Java Web Start check to make sure the student has the correct 
software to run Elluminate. Finally, there are online orientation recordings that can 
be watched as well as downloadable manuals that show you how to use Elluminate.
http://www.elluminate.com/support/
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Elluminate Training: 
Includes recorded trainings and downloadable manuals for both moderators and 
students.
http://www.elluminate.com/support/training/

UAF Offi  ce of Information Technology for Elluminate Support: 1.800.478.8226
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With so much information available online it is now too time consuming to visit all of 
the web sites you want to follow, especially if your students all have their own blogs. 
Aggregation is an effi  cient way to gather all the news/information/content you want 
into one place, saving you time.

RSS Feeds
RSS stands for “Really Simple Syndication” or “Rich Site Summary”, depending on 
who you talk to. RSS feeds make it possible for people to make content available 
online for anyone to “pull” down whenever they want it. 

Sites that employ feeds enable others to access their content through their own set 
of  preferred tools. Feeds are written according to a machine-readable standard that 
allows content to be portable. This means that a web site that publishes a feed can 
be read by anything that understands the standard. In turn, the feed can read by a 
person who might remix the content with their own and in turn, reuse that content.

How Do I Find A Feed?
Subscribing to an RSS feed of a web site you want to follow allows you 
to access the site content without actually going to the web site. To sub-
scribe, look for an orange icon like the one to the right.  There are a few 
other icons that also indicate a feed is available. Depending on the web 
browser you use you can fi nd available feeds:

Aggregation & Feeds

Firefox feed icon

Flock feed icon

Internet Explorer feed icon

Netscape feed icon
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Feed readers, sometimes called news aggregators, are software clients that collect 
the feeds you want to “subscribe” to. The reader then gathers all the latest news 
and posts from the sites you are subscribed to and allows you to read them all in one 
place. This is the part that saves you time because you don’t have to go to each site 
and search to fi nd the latest news. The reader searches for you and “pulls” the new 
content for you to read.

There are numerous readers available to use for free:

Web-based
 • Google Reader - http://www.google.com/reader

 • BlogLines - http://www.bloglines.com 

 • PageFlakes - http://www.pagefl akes.com

 • NetVibes -  http://www.netvibes.com

Client Software
 • BlogBridge - http://blogbridge.com/

 • More clients can be found at the Open Directory Project:
 http://dmoz.org/Computers/Software/Internet/Clients/WWW/Feed_Readers/

Hybrid
 • Firefox Extensions (web browser) - http://www.getfi refox.com

 Sage - https://addons.mozilla.org/en-US/fi refox/addon/77
 BlogRovr - https://addons.mozilla.org/en-US/fi refox/addon/4689
 Wizz RSS NEws Reader - https://addons.mozilla.org/en-US/fi refox/addon/424

 • Feedly - https://addons.mozilla.org/en-US/fi refox/addon/8538 
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Google has an online feed reader 
called Google Reader. To get start-
ed with Reader, go to the URL and 
sign in with your Google account 
(the same account we used to sign 
up for Blogger).

After logging in you will see the 
Reader interface. If this is your fi rst 
time in Reader you will not see any 
feeds in your left sidebar.

Subscribing to a Feed
1. Copy the feed URL from the web site 
 you want to subscribe to

2. In Google Reader, paste the feed URL 
 in the text box and press Enter

3. You feed is added

Managing Feeds
After subscribing to a few sites you may 
benefi t from organizing the feeds you’re 
subscribed to. To manage your feeds in 
Google Reader use the MANAGE SUB-
SCRIPTIONS link at the bottom of the 
left sidebar.
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Subscriptions are 
assigned tags so that 
they are easier to fi nd 
and so that feeds with 
similar content can be 
sorted together. Use 
the drop-down box to 
add a new tag if the 
tag you want to use 
is not already there. 
Select that tag and 
assign it to a subscrip-
tion.

Subscriptions can also be sorted by fold-
ers. The drop-down box on the right of 
each subscription entry allows you to se-
lect a folder, or folders to assign. You can 
also add a new folder from here.

When you are fi nished managing your 
subscriptions use the BACK TO GOOGLE 
READER link.

Reading Subscriptions
Your subscriptions are all 
displayed (or are sorted) in 
the left sidebar of the Google 
Reader interface. To read 
them you can either click on a 
subscription to see all unread 
content in the feed, or click on 
a folder to see all of the unread 
content in the entire folder.

Clicking on the title of a post or the gray 
arrow beside it takes you to the original 
source of the article. This is particularly use-
ful if a feed displays only part of the article.
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As you read 
through your feeds 
items they can be 
marked as being 
read. In list view, 
items are marked 
as read when you 
click on them. In 
expanded view, 
items are marked 
as read when you 
scroll past them. 
Un-check the 
mark-as-read box 
to leave the item 
unread.

Sharing
There are three ways to share what you are reading in Reader - The Share button, 
the Shate with Note button, and Email. Use the Share button to add an item to your 
public (SHared Items) page. Your public page is an easy way to share items of interest 
with your friends and family. The Share with Notes button allows you to add a com-
ment to the article you are sharing. The Email button allows you to email the item to 
a specifi c person.
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Technology Readiness
When teaching online you must be ready to serve as the fi rst level of technical sup-
port for your students. Primarily this means realizing that each level of technology 
that is needed places demands on your time, particularly at the beginning of a semes-
ter or the start of a new class. 

If you are using Blackboard, have an assignment that helps the students learn the 
system before they start trying to learn and perform. We recommend a method that 
has proven successful in the past: the Blackboard Scavenger Hunt (see Teaching Tip: 
A Blackboard Scavenger Hunt).

If you are using a synchronous tool for class sessions or offi  ce hours, make at least 
the fi rst session mandatory and plan to spend that session helping students get into 
and learn to use the basic functionality of the tool.

If you are requiring particular software tools and techniques (Word revision tracking, 
equation editing, VoiceThreads) link your students to existing resources for help and 
provide some documentation to help them get started.

Each new tool you introduce (discussion board, mailing list, blog) will create some 
amount of initial time to implement and some management time and responsibilities 
to your schedule.

Response Time and Consistency
Regardless of the means of communication that you promote or require your stu-
dents to utilize, it is critical that you manage expectations of—and provide consis-
tency in—your response times. Each student should know how long they can expect 
to wait if they send you an email or when they will be able to interact with you during 
your next session of offi  ce hours.

Email
Email is the bedrock communication means in online distance education. It can be 
enhanced—but never replaced—by a plethora of tools, some of which are discussed 
here. Using email eff ectively, as well as dealing with the demands of high-volumes of 
important email, are important skills for any contemporary instructor.

See the Teaching Tip: Handling Email Overload for specifi c ideas to make email work 
for you.

Classroom Communication 
and Management
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Daily, Weekly, and on Demand
Regular communication between student and instructor is vital to student success. 
Experience consistently shows that those students with whom an instructor has the 
earliest contact, and those students with whom there is the most communication, 
will have the highest rates of course completion. It is easier to just do your part to 
facilitate this communication than to attempt to solve the chicken-and-egg statistical 
conundrum inherent in the experience!

Every online instructor should plan time in their schedule for daily contact with se-
lected students, weekly contact with the class, and on-demand responses:

 • Daily email includes responses to questions and assignments and, most 
importantly, proactive communications with students to reassure them that you 
are there and that you are paying attention to their progress. Sending an email or 
two (depending on class size) means you will have some contact with even the 
most reluctant learners every few weeks. There is an added benefi t in helping you 
learn more about—and remember—your individual students without the benefi t 
of regular face-to-face interaction.

 • Weekly email should be sent your entire class. If you are teaching a semester-
based or cohort class, then this can include information about upcoming material 
and assignments. If you are teaching a radically asynchronous class, this message 
should at least include contact information, information about offi  ce hours, and 
a personal message to your students of some kind. Students tend to respond 
positively to email that includes tips or pointers to events in the news or popular 
media that relate to the course.

 • On-Demand Email is that which is sent in response to student queries and 
assignment submissions. You will want to set aside a couple of regular weekly 
time to process this kind of email. Unless you are traveling or otherwise unable to 
access email for logistical reasons (students should, of course, be made aware of 
this), email shouldn’t sit without response for more than 3-5 days. Your students 
should be made aware of this response time so they don’t have to fret over 
whether the mail arrived, if they asked a ‘stupid’ question, if their assignment was 
lost, if you are ignoring them, etc.

Email Accounts, Clients, Folders and Organiza-
tion
The Google Mail system now employed at UA happily makes the need for multiple 
email accounts a thing of the past. The Teaching Tip: Handling Email Overload can 
help you get started with simple-to-use (and no tech support or setup needed) email 
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aliases and folders (labels) to facilitate greater ease handling email for multiple 
classes without dividing your activity across accounts.

Archiving
Keeping an archive of email for past semesters is important in case of disputes that 
can occur long after a course term has ended. The Google Mail system provides 
enough space that you can retain mail—stored in folders so it is out for your way-- for 
years.

Traditional Mailing Lists
A traditional mailing list is a service to which you and your students “subscribe” and 
then all messages sent to the mailing list address are automatically distributed to the 
students. Like discussion boards, some students will take well to this medium and 
others will need more coaxing. The advantage of the mailing list is that it provides 
another simple means of promoting and creating class community within an interface 
and application that all students will be familiar with. 

UAF does provide mailing list services (http://www.uaf.edu/listowners/listform.html), 
but you might fi nd that you want more fl exibility and services, in which case we have 
made some suggestions below:

 • Yahoo Groups: http://groups.yahoo.com/

 • Google Groups: http://groups.google.com/ 

Offi  ce Hours
Offi  ce hours are an important time for individual and small-group communication as 
well as reassuring your students that, even in a distance education setting, you are 
available to help them outside of regular class sessions. You are likely to discover that 
offi  ce hours are more often used for socialization than assistance, particularly if you 
provide an open area for group interaction in addition to a private channel to commu-
nicate with individual students. This social aspect of the medium is a good thing for 
sustaining the learning community in your classroom… don’t discourage it!

On the class syllabus and web site, list your offi  ce hours and time-zone. You should 
set aside at least two periods per week during which you will be available. Don’t be 
intimidated by the amount of time—like face-to-face offi  ce hours you can work on 
other things while you are waiting for students to take advantage of your availability.
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Multiple short blocks of varying times (e.g. one in the afternoon, one in the evening, 
one on a weekend day) will likely be more eff ective than a few long sessions. If you 
are using audioconference, or another metered technology to hold offi  ce hours, 
make your students aware that you will wait on the line for a set amount of time for 
students to join the conference.

For online classes, there are a variety of low-bandwidth web-based tools that can be 
used to hold offi  ce hours:

 • Blackboard Virtual Classroom and Blackboard Chat (http://classes.uaf.edu/) 
are simple communication and collaboration tools built into Blackboard which 
can be used to create scheduled live-chats and synchronous sessions which can 
be used for offi  ce hour activities. This Quick Tutorial demonstrates how both 
tools work: http://www.blackboard.com/quicktutorials/collaboration.swf and this 
document lists the steps to create either kind of activity space: 
http://help.unc.edu/5474  

 • Instant Messenger (IM) is a common, synchronous technology that will 
already be familiar to many students through personal use. With IM, you can have 
a real-time text conversation with a student (multiple students can be included 
in the same conversation or you can have multiple conversation windows open, 
each with a single student). There are a variety of IM clients that students might 
already be used to from their personal use of the web. A multi-client tool like 
Trillian, Miranda, or Fire can be used to allow you to interact with students using 
diff erent tools. However, these multi-clients do not generally support the more 
advanced features that might be found in the dedicated IM client, such as fi le 
transfers, shared whiteboard, two-way audio, shared web browsing, or basic ap-
plication sharing.

 • MSN Instant Messenger
http://messenger.msn.com/ 

 • Yahoo Instant Messenger
http://messenger.yahoo.com/ 

 • Trillian Unifi ed Client for Windows
http://www.trillian.cc/ 

 • Miranda Unifi ed Client for Windows
http://www.miranda-im.org/ 

 • Fire Unifi ed Client for Mac
http://fi re.sourceforge.net/ 

 •  Meebo (http://www.meebo.com/) is a web-based Instant Messenger program that 
can be used to talk to students using various IM programs without even needing to 
install a client.
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 •  Skype (http://www.skype.com/) is an increasingly popular service for two-
way audio and IM that is unobtrusive and of relatively high quality. As a mecha-
nism for two-way (and small group!) audio it works quite well and it has the 
advantage of being relatively common in the “real” world.

 • Elluminate Live (http://elive.uaf.edu/)  is a full-fl edged synchronous class 
session tool which provides facilities for sharing PowerPoint presentations, 
text chat, two-way Internet audio, polling, shared whiteboard and even applica-
tion sharing. With these features come increased technology and bandwidth 
demands. Each user must have a relatively modern computer running the latest 
version of Java and—if using two-way audio—headphones, microphone, and 
relatively stable Internet connection. If you are not planning on using features 
beyond two-way chat and/or simple audio, then would probably be better served 
with a less demanding application such as some of those mentioned earlier.

Assignments and Deadlines
Assignment Transmission

Handling the fl ow of assignments, corrections, and revisions can be a surprisingly 
diffi  cult process. You will need to identify a few functional paths for your students 
to use and explicitly disallow using other methods except under exceptional, pre-
approved circumstances. If you are planning to rely on transmission of fi les (word 
processor, PDF, image, application fi les, etc) rather than just plain text, there is an 
extra level of management to consider.

For UAF online instructors there will be a few primary mechanisms:

 • The Assignment content type in Blackboard is intended to replace the digital 
drop box for lesson transactions. Assignments have a few important advantages 
over the drop box as a mechanism for homework and other document intake: 
items are directly refl ected in the grade book for purposes of tracking and grad-
ing, and students have pre-defi ned mechanism for assignment submission that is 
within the fl ow of the content organization. This means no more missed assign-
ments, mail lost in translation, attachments that can’t be opened, etc.

 • The Blackboard Digital Drop Box allows you to transfer fi les to and from 
students within Blackboard. This is a convenience, particularly because you can 
archive a number of fi les in Blackboard for distribution at any time in the future. 
However, because Blackboard doesn’t notify you (or students) when new mate-
rial has been transferred, this service is most often used to distribute planned 
material (accompanied by an announcement) or following a request by a student. 
If you use the drop box, you must remember to check for new materials at least 
every few days. Posting to the drop box from slow, remote connections can also 
be quite slow for large fi les.
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 • Mailing Lists and Bb Discussion Boards both allow (assuming local confi gura-
tion doesn’t disallow it) attachments in addition to the plain text, and thus can 
be used for assignment submission. Obviously, since these are generally public 
forums, you would only want to do this if you wish the students to share their 
work with others or as part of a peer review process.

 • Email is often a comfortable approach for lesson transmittal, but it is also the 
one most prone to issues and most open to abuse.

 • Paper Mail/Fax are still valid alternatives, particularly if you are doing work in 
the math/sciences where you need to capture symbols or other work processes 
that are hard to create using word processors or via plain text. If you are using 
fax, we highly recommend a fax-email service such as eFax (http://www.efax.
com/), which allows you to receive faxes to your email, send faxes from the web, 
and fax from any application that you can print from.

File Formats
UAF students are not included in the UA licensing for Microsoft Offi  ce and other 
standard applications we might use as educators. If you want to take advantage of 
Microsoft Word Revision tracking, for example, you will need to ensure that your stu-
dent population has access to Microsoft Word or is informed about a free alternative 
such as Open Offi  ce (http://www.openoffi  ce.org/). PDF contains great markup and 
commentary tools but these are only partially accessible to students who have only the 
free Acrobat Reader product (and they will not be able to create PDF fi les for you).

Diff erent curriculum has diff erent demands, and there are successful classes that de-
mand Word (or Open Offi  ce), Excel, some kind of Equation Editor, etc. but you have to 
make a conscious choice and understand the implications for your students (not just in 
obtaining the software, but in learning to use it and the time it might take to do so). 

Timing and Deadlines
Distance education has become a popular option for students in part because of its 
fl exibility with regards to time and performance. Online instructors have to seek a 
personal balance between creating an expectation of time-based performance and 
providing the fl exibility that is needed for their often non-traditional learners to succeed.

Your students need to know what the deadlines are (these may be based on discrete 
dates or, in the case of open-entry classes, performance periods) and when they can 
expect grades and evaluative feedback. And of course, you must respect the dead-
lines too!

Radically asynchronous courses have to be based on performance periods beginning 
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with a student’s entry into the class. Provide duration guidelines (by Week X, by X 
weeks from enrollment) for these students and, as part of your regular email con-
tacts, help the students assess their performance. Don’t let the prospect of managing 
these details deter you from providing this feedback that might be most critical in 
ensuring student success. Additionally, make use of online grade books, announce-
ments, and entry points when facilitating online discussions to reiterate expectations 
and document progress (or lack thereof).

At the same time that you are creating a professional educational environment you 
want to remain fl exible and adaptable to the needs of your students. In addition to 
all the “normal” hindrances and obstructions faced by students, online learners may 
encounter unexpected technical diffi  culties. It can be more diffi  cult to evaluate truth-
fulness when faced with an excuse proff ered by a distance student, and no instructor 
has time to grade large chunks of course material turned in late and/or at the last 
minute, so exceptions to deadlines and performance goals should be clearly excep-
tions in your students’ minds rather than an expectation.

Academic Honesty and Assessment Integrity
Cheating happens, and there is research that the rate is rising on college campuses 
across the country… particularly in the form of plagiarism. The online educational 
environment is not necessarily worse than the face-to-face classroom, but the lack of 
proximity and a traditional reliance on conventional, selected response assessment 
methods has made many educators more aware of the issues than they would be 
otherwise.

There are a few basic ways to cheat, and for each there are strategies for remediation:

Plagiarism is the most common form of cheating and can be combated in a number 
of ways:

 • Emphasize the art of citation… don’t assume that your students already 
know how to cite properly and integrate external resources into their products, 
and don’t allow them to feel bad if they don’t!

 • Utilize process writing techniques in which students need to produce mul-
tiple drafts

 • Utilize refl ective exercises where students have to engage in meta-cognitive 
thought about their performance

 • Assignment Sharing entails any number of versions of the age-old “steal a 
copy of the test” routine that has been happening since the days of Professor 
Fred Flintstone. Some remediation strategies are to:
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 • Create new assessments

 • Rotate and randomize assessment questions from question pools

 • “Reveal” the test for a limited amount of time

 • Put time limits on the assessment

 • Require a proctored testing environment

 • Paper Mills provide a ready resource for plagiarizing entire documents, but 
you can often detect such papers with additional strategies such as:

 • Careful reading and evaluation of the paper along with citation spot-checking

 • Familiarize yourself with common paper mill web sites and their products

 • Using Google to search for suspicious phrases (those that display an awkward 
fi t, are extraordinarily advanced, have citations pointing to rare material, etc.)

 • Use Blackboard’s SafeAssign system (see below)

As an educator you will do well to place an emphasis on more “authentic” assess-
ment techniques involving performance over time, personalization, and current 
events which are not only often more eff ective indicators of understanding, but also 
make cheating more diffi  cult. Look at the possibility of cheating as an opportunity to 
reconsider your assessment strategy, your use of self-assessment and other forma-
tive assessments, and to implement new techniques for communication that are 
enabled through technology.

Every class syllabus and web site should have a clear institutional statement regard-
ing academic honesty. More importantly, each class you teach should contain a 
personal statement from you detailing why you care and the fundamental reasons 
the students should care as well!

Blackboard SafeAssign is a tool built into Blackboard which automatically compares 
student papers with a large database of papers, articles and reference material, iden-
tifying simple plagiarism. SafeAssign can be used in two ways:

 • As an automatic process during assignment submission
 http://tinyurl.com/c2za6j

 • As an ad-hoc tool to spot check particular papers
 http://tinyurl.com/dlwtck 

Also see the Teaching Tip: Assessment Integrity for more information.

Web Research, Knowledge Management, Currency
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RSS (web feeds), Google Reader, and del.icio.us are tools for capturing information, 
keeping current, and sharing with others to try to keep current with trends in online 
teaching, selected technologies, and your discipline!

See:

 • RSS for Educators [word]
 http://www.lo.redjupiter.com/gems/weblogged/RSSFAQ2.doc 

 • Blogging and RSS for Educators
 http://www.infotoday.com/MMSchools/jan04/richardson.shtml

 • Google Feed Reader: http://www.google.com/reader/ 

 • Del.icio.us Social Bookmark Manager: http://del.icio.us/ 

 • Diigo Social Bookmarks and Web Annotation: http://diigo.com/ 
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Copyright Issues
Fair Use principles for the online classroom are not signifi cantly diff erent from those 
in the face-to-face classroom, but the scrutiny in such situations is often much higher. 
Common practices that are in the gray areas of the law (or outright contradict it), 
such as using the same photocopies from a newsmagazine each semester, are more 
exposed in the online environment, where you must build curriculum materials well 
ahead of time.

In addition, the authoring environment for online materials and the wealth of re-
sources available on the Web make it ever easier to cut, paste, copy, and duplicate 
information.

The bottom line is, if you wish to use material created by others, and you want to 
use more than 10% or 1000 words of a longer article, multiple illustrations or tables, 
complete short articles, you really should obtain permission to do so.

You do not need permission to link to any publicly available resource, given that you 
do not frame the content in a misleading way nor copy the material to another server 
or location.

For more information see the Teaching Tip: Copyright, Fair Use and Educators.

Share and Share Alike
On the fl ip-side of the copyright issue is that of how to share your material in a 
protected, productive way. There are many ways to share course materials with your 
colleagues, from making it available using your UAF Faculty web space to formally 
packaging material up into a technically correct “learning object.” Most learning 
object repositories accept submissions of all kinds of materials, including Word/PDF 
documents, image fi les, multimedia fi les, HTML pages or links to existing web sites. 
Contributing in this way helps create a healthy information ecology.

There is a developing school of thought that—thanks to the oversized infl uence of 
conglomerate media companies—copyright restrictions and durations have become 
greatly exaggerated and onerous. After one change in 100 years of service, copyright 
protection has since been changed many times, extending protection to 98 years and 
granting automatic registration and extensions. Ironically, the companies that have 
been most persuasive in their lobbying to extend and enhance copyright protec-
tion—such as Disney—would not exist were it not for the public domain which they 
seek to obliterate.
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When making material available to the public, you have the option to use a less 
restrictive Creative Commons (CC) license (see http://creativecommons.org/) which 
allows you to select your protections in terms of whether or not you require attri-
bution, whether you allow modifi cation, and whether or not you allow commercial 
uses of your work. Select your options and you will have a tested, legal license that 
you can affi  x to your work. In addition, digital media can be given specifi c “metadata 
tags” which can be searched and used by special search engines to create a search 
facility for CC licensed material, a vital fi rst step towards rehabilitating the public 
domain that our intellectual foundation rests upon.

See:

 • Free Culture by Lawrence Lessig clearly (and entertainingly, believe it or 
not) lays out the deep problems in our copyright system and the gutting of the 
public domain on which our artistic and intellectual strengths lie. Freely available 
in many format at: http://free-culture.org/freecontent/ or purchase a copy at your 
local bookstore

 • “The Progress of Science and Useful Arts: Why Copyright Today Threatens 
Intellectual Freedom”
 http://www.fepproject.org/policyreports/copyright2dexsum.html

 • The Value of the Public Domain
 http://homepages.law.asu.edu/~dkarjala/OpposingCopyrightExtension/pub-
licdomain.html 

 • Creative Commons: http://creativecommons.org/ 

The Weekly Routine
Rather than provide a sample schedule, it might be useful to just recap some of the 
important actions that you may need to accommodate in your weekly online teaching 
routine (not counting traditional activities):

 • Daily email check, responses

 • Daily gradebook updating

 • Twice weekly automated quiz check

 • Twice weekly discussion forum post and check

 • Thrice weekly digital drop box check

 • Weekly pro-active email

 • Weekly (min) synchronous offi  ce hours

 • Regular announcement postings, updated, content updates
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Teaching Tip: 
Assessment Integrity
Every instructor, whether a distance educator or not, faces the issue of promoting 
and enforcing standards of academic integrity… a concern only highlighted by the 
distributed student population in a distance course.

Defi ning the Problem
Studies indicate that academic dishonesty is on the rise among high-school and col-
lege age students. There’s no evidence that cheating is more common in distance 
education. Advances in computing technology and the ubiquity of the Internet have 
reduced the barrier between the impulse to cheat and the actual practice of doing so.

Coping Strategies
 • Develop a clear class policy. Provide a statement to your students explaining 

the importance of academic integrity and what you expect from them. But don’t 
stop here! Create an atmosphere of support and trust: outline what you expect 
from yourself as an instructor, provide access to information about how to use 
outside resources, and give directions for obtaining help.

 • Utilize Technology. The Blackboard system allows you to assign password 
protection and time limits to quizzes and tests which can be automatically cre-
ated using random selections from large pools of test questions. 

 • If you suspect plagiarism you can use the SafeAssign feature in Blackboard 
to scan for plagiarism automatically or on demand. You can also simply search for 
unique phrases with Google.

 • Change-Up Your Curriculum. Assign less common readings and ask diff erent 
questions. Tie your assignments more closely to your individual class materials 
and discussions. Change your assignments each term. Add your unique perspec-
tive to put a “twist” on assignments. This is likely to be more interesting for both 
you and your students!

 • Focus on Process. By attaching importance and expectation to process, you 
can spread the weight of a grade out, taking away much of the motivation for 
cheating. This can take the form of keeping drafts, copying research materials, 
having students write up the research process, benchmarking, etc.

 • Rethink Your Assessment Strategy. Sometimes the “quiz-quiz-test” cycle re-
mains in place out of habit. Take some time to think about exactly what you want 
your students to learn and what other ways might exist to assess the eff ective-
ness of your instruction. Perhaps portfolios, structured writing assignments, dis-
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cussion, games, role-playing or other less traditional tools can be of use, leaving 
traditional tests and quizzes for reinforcement and self-assessment (or for use in 
proctored situations).

 • Require a Proctor. The Center for Distance Education has a standard process 
for remote students to access proctors in their community… there’s more over-
head involved in this approach, but it is undeniably more secure.

Positive Eff ects
Each of these strategies for dissuading dishonesty is also a potential point for improv-
ing the educational experience. While it is important to stand fi rmly for—and as an 
example of—academic integrity, the challenge of creating more “cheat resistant” 
curriculum materials and assessments can help you more clearly identify what is re-
ally important to you as an instructor and create a richer and more diverse curriculum 
for your students.
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The Blackboard Learning Management system can be a valuable addition to just 
about any class, but to be eff ective students must know how to use it! Take some of 
the drudgery out of the process by allowing your students to discover by doing—in 
this case by utilizing a simple, but eff ective, Blackboard Scavenger Hunt. 

Learning Objectives 
Students familiarize themselves with the following primary Blackboard tools/areas: 

 • Announcements 

 • Syllabus

 • Assignments/Course Documents

 • Discussion Boards 

 • External Links

Students demonstrate their mastery by completing a brief Blackboard assessment. 

Format/Process 
1. Place the “items” in the appropriate locations in your Blackboard course in vari-
ous formats (items may be part of regular class materials or special items posted just 
for the Scavenger Hunt) for example:

 • in a Blackboard Announcement 

 • in a document in the Course Information area 

 • in a folder within the course documents section 

 • in the class syllabus 

 • in a discussion board posting 

 • in a document passed to the student using the Digital Drop Box 

2. Create a short, point-bearing Blackboard quiz asking for the items they found 
and make it available. 

3. Create a handout (paper, Word, PDF, or text) outlining the Scavenger Hunt 
items, tips on locations, and a place to note answers. Don’t forget to indicate where 
they go in your course to take the quiz. 

4. Provide the handout to students as early as possible in the semester, prefer-
ably before asking students to use Blackboard to access course curriculum. Finally, 
students will complete a short, graded, point-bearing Blackboard quiz using the items 
they have found. 

UAF CDE Teaching Tip: 
A Blackboard Scavenger Hunt
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Examples
The key to successful Scavenger Hunt is to make the items being sought fun and/or 
relevant to the curriculum. For example, UAA faculty devised an exercise in which 
students search for words to complete an amusing limerick. You could similarly have 
students fi nding parts of a theorem, the names of authors, quotations, medical 
terms, chemical scientifi c names, or other kinds of information might be relevant to 
your class.

Another approach would be to devise an assignment using parts of the course and 
syllabus, as you can read about in this paper from Merlot: “Scavenger Hunt Enhances 
Students’ Utilization of Blackboard” (http://jolt.merlot.org/Vol2_No2_Jones.htm)
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With a new semester quickly approaching, many instructors fi nd themselves revis-
ing old materials and creating new syllabi. Being creators themselves, it behooves 
instructors to pay attention to copyright law, which protects the rights of those who 
create materials while ensuring educational access. A quick review of copyright at 
this point in the process can save a lot of trouble later on!

About Copyright Law
Original materials are automatically protected by copyright upon creation and for at 
least 50 years beyond the death of the author. The exclusive rights of the copyright 
holder include:

 • Reproduction of the copyrighted work

 • Distribution of copies of the work as sales, rentals, lease, or gifts

 • Rights to perform or display the work publicly

About Fair Use
“Fair Use” is a concept defi ned by the Copyright Law of 1976 that defi nes situations 
in which copyrighted material may be used without permission. The three primary 
considerations for determining fair use are: brevity, spontaneity, and the cumulative 
eff ect. In other words, selections should be short, included “on the fl y”, and should 
not have the eff ect of limiting sales. The law itself defi nes the conditions for fair use as:

 • The purpose and character of the use must be educational or non profi t in nature.

 • Copied material must be an excerpt or a portion of the original work without 
being a critical portion.

 • The teacher may not impair the marketability of the work

Educator Guidelines
Current technologies such as the Internet, high-speed copiers, and scanners, make 
abuse of fair use all too easy. Educators and publishers have come up with an infor-
mal set of guidelines that defi ne fair use in education:

 • A complete article or story less than 2,500 words; 1,000 words or 10% (which-
ever is shorter) of a prose work that is excerpted; one illustration, chart, diagram, 
or picture per book or periodical issue; a short poem of less than 250 words, or an 
excerpt of a longer poem of not more than 250 words.

Teaching Tip: 
Copyright, Fair Use and Educators
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 • The copying must be for only one course, and no more than one short poem, 
article, or story or two excerpts can be copied from the works of one author.

 • Unauthorized copying may not be used to replace an anthology or compilation.

 • Unauthorized copies may not be made of consumable works such as work-
books or standardized tests.

 • Unauthorized copying may not substitute for the purchase of books, autho-
rized reprints, or periodicals.

 • The same instructor may not copy the same item without permission from 
term to term.

 • Students cannot be charged beyond the actual cost of photocopying.

Multimedia Materials
Fair use generally allows for presentation of video and multimedia materials in the 
classroom, such as playing a video the class. The same holds true in a distance educa-
tion context, with the exception that the broadcast of the material to the students 
must be in a closed circuit (limited to enrolled students only), delivered real-time, and 
cannot be archived. This is important to remember if you plan to use video materials 
in a videoconference class!

More Information

For more information, contact us, or peruse the following resources:

 • Copyright Law of 1976: http://www.loc.gov/copyright/title17/

 • The University of Texas “Rules of Thumb”: 
 http://www.utsystem.edu/ogc/intellectualproperty/copypol2.htm 

 • Intellectual Property and Copyright:
 http://www.uwex.edu/disted/intprop.html 

 • The “4 Point Test”: 
http://fairuse.stanford.edu/Copyright_and_Fair_Use_Overview/chapter9/9-b.html 

 • Questions and Answers on Copyright for the Campus Community: 
 http://www.nacs.org/public/copyright/ 
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Email communication is de rigueur in today’s environment, providing a welcome op-
portunity for interaction in almost any course. But the sometimes massive email traf-
fi c associated with a course can also leave one feeling overwhelmed and ill-equipped 
to respond adequately. In this Teaching Tip we look at some coping strategies.

Learn Your Client
Google Mail is nearly as good as a desktop client (and in some ways better). The stor-
age capacity, search features, and availability from anywhere you can access the web 
make it imperative that you learn to use it adeptly. As you could with the former UA 
email system, you can still use a desktop client if you prefer, using the Google Mail 
web application occasionally if at all… but the same lesson applies here: learn the 
capabilities of your client to save time and eff ort.

Getting Organized with Folders and Filters
Organizing your email is a fundamental management strategy. For this task, folders 
(called “labels” in Google Mail) are your friend. Use folders to separate email into 
manageable groups that will not get lost in your busy inbox. Typically you should as-
sign a folder for each class you teach. 

You could manually sort mail, but it’s much more productive to perform this task 
automatically using aliases and fi lters.

Aliases are automatically supported by the UA Google Mail system. Simply add a 
‘+’ sign followed by the alias you wish to use. For instance, if your email address 
were hjsimpson@alaska.edu you could add an alias for a class by using the address 
hjsimpson+engl213@alaska.edu and the mail will still come to your account. No spe-
cial setup necessary.

Filters are available in Google Mail (and other capable clients) to automatically detect 
mail sent to a particular alias and fi le it appropriately. For help setting up fi lters, see 
the Google Help document “Using Filters” (http://tinyurl.com/gmfi lters) 

Expectations and  Response Time
Expectation is a powerful and unpredictable force. You must make clear to your 
students what they can expect from you in terms of response time. They should 
know that instant responses might sometimes occur serendipitously, but not all the 
time. A predictable two day turnaround time is more valuable to your students than 

Teaching Tip: 
Handling Email Overload
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an unpredictable time that varies between one-hour at some times and four or more 
days at others. For this reason, your response time policy should include a minimum 
and a maximum limit. 

When the time comes to answer email, provide an adequate answer! Where possible, 
include direct reference(s) to the original message. You don’t have to be profound, 
but you should clearly and directly communicate. Be opportunistic and take advan-
tage of this contact to personally engage the student, reassuring them of your pres-
ence and willingness to assist them, and providing relevant contact, web address, 
and other information in your signature.

Copying and Pasting is OK
Sometimes teachers avoid cutting and pasting replies and other email communica-
tions to students because it feels like “cheating.” But this is untrue… as long as the 
communication is accurate and timely, the method used to create it doesn’t really 
matter! Many instructors have created methods to enable quick responses to com-
mon questions:

 • Keep a simple text fi le or word document to copy and paste from

 • Learn to access and copy text from messages in their Sent Mail folder

 • Use the BCC (Blind Carbon Copy) feature to send the same message to mul-
tiple students without revealing their email address to each other

Address Books and Mailing Lists
All clients provide some way to store contacts and create lists. Taking the time to create a 
mailing list for your classes will pay dividends in the future because it becomes simple to 
do more than just respond to inquiries, but to be active and initiate communication.

Be Proactive
If you master your email client and techniques it can be a powerful ally in the fi ght for 
your student’s attention. Sending an email or two each week—reminding students of 
assignment due dates, noting something from the news or popular media, providing 
a quick tip—can have a marked eff ect on performance and retention. Informal com-
munications are the glue that makes a course “sticky” for the students.



Workplan

Work Plan for Completing Course Development

Completed this week:

Remaining tasks:

Next steps:
(from the list above, what are the 
next five things you need to 
accomplish?)

Do you have all the knowledge
and information you need to 
complete these tasks?

If not, what’s missing?

What decisions do you still
need to make about this 
course?

Which tasks will be most
challenging?

When will you tackle those 
items?

Sketch a timeline or create a
scheduled list of your plans
for completion.
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